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E D I T O R I AL

This magazine was created using :

WELCOME TO ANOTHER ISSUE OF FULL CIRCLE.

P

ython makes a triumphant return this month, but still no Blender again this month I'm
afraid. If you read last month's issue you'll know that Nicholas is now officially a father
and has probably only slept a handfull of hours this month. Completing the trinity (with
LibreOffice) is an interesting article on managing multiple passwords with a BASH script.
Very different!
Inkscape also continues as normal and is joined with the fourth in our series of kernel
articles and Charles returns with a second part to his Kodi (formerly known as XBMC) series.
Why I remember installing XBMC onto an Xbox. The first Xbox no less! OK, I'm giving away my
age. I'll stop now.
Elementary OS is reviewed as is the book (kindly gifted to us by Packt Publishing) Web
Development with MongoDB andNodeJS by Jason Krol. Lucas touched upon NodeJS in a
previous Command and Conquer article. So, it's only natural that he should review the book.
As ever, please support Packt as they're one of the few publishers who send us books for
review.
This month brings to an end my current Arduino project, but I'll have something new for
you to do next month. Fear not!

Full Circle Podcast

Released monthly, each episode
covers all the latest Ubuntu news,
opinions, reviews, interviews and
listener feedback. The Side-Pod is
a new addition, it's an extra
(irregular) short-form podcast
which is intended to be a branch
of the main podcast. It's
somewhere to put all the general
technology and non-Ubuntu stuff
that doesn’t fit in the main
podcast.

Hosts:

Anyway, enough rambling from me. I hope you enjoy the issue.

• Les Pounder
• Tony Hughes
• Jon Chamberlain
• Oliver Clark

All the best, and keep in touch!
Ronnie
ronnie@fullcirclemagazine.org

http://fullcirclemagazine.org
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N E WS
U BUNTU O NLINE SUMMIT
FOR U BUNTU 1 5.04 (VIVID
VERVET)

T

he Ubuntu Online Summit is an
event that allows the Ubuntu
community to contribute to the
development of the operating
system by taking part in
discussions with the developers. It
features a lot of topics regarding
the system, some more complex
than others, but pretty much all of
the aspects of the distribution will
be covered.
The current summit is
scheduled to take place right after
the Ubuntu 1 5.04 (Vivid Vervet)
development cycle has started.
Users will be able to find out about
the features that are going to be
integrated in Ubuntu ahead of
time, and they will be able to query
the developers about any subject.
If you have any questions about
Ubuntu (not technical support
related), if you want to know why
something is implemented in a
certain way, or you just want some
general information, then the
Ubuntu Online Summit is the place

to ask them.
Source:
http://news.softpedia.com/news/U
buntu-Online-Summit-for-Ubuntu1 5-04-Vivid-Vervet-Starts-In-a-FewDays-464323.shtml
Submitted by: Silviu Stahie

M OZILLA RELEASES
‘FIREFOX D EVELOPER
EDITION ’ FOR WINDOWS,
M AC AND LINUX

T

he Developer Edition is exactly
what it says on the tin: a
browser built around the needs of
web developers.
The Firefox team set out to
bring together tools needed to
keep developers productive across
a multi-device and multi-platform
environment, “creating a focal
point to streamline your
development workflow.” Though
the Firefox Developer Edition has a
touch of the familiar, the rejigged
UI and features make it a
formidable development
full circle magazine #91

environment while still the fully
capable browser Firefox users
know and love.

experimental branch.

The Dropbox developers don't
usually provide too many changes
The biggest change you’ll notice for the Linux platform and the
is the dark UI of the slick inspector latest update is not all that
applied to the rest of the browser. promising either. In fact, there is
Not your style? You can revert to
nothing specific for Linux, but the
the familiar light theme by heading branch is an entirely different
into the Customize options at the
discussion. This will be a very
bottom of the “hamburger” menu
interesting release when it
and clicking “Use Firefox Developer becomes stable, but until then we
Edition Theme”.
can take a closer look at what's
coming.
Source:
http://www.omgubuntu.co.uk/201 Source:
4/1 1 /mozilla-releases-firefoxhttp://linux.softpedia.com/blog/Dr
developer-edition
opbox-2-1 1 -34-ExperimentalSubmitted by: Sam Tran
Features-a-Rewritten-UI-for-LinuxClient-464468.shtml
Submitted by: Silviu Stahie

D ROPBOX 2.1 1 .34
EXPERIMENTAL FEATURES A CANONICAL D ROPS U BUNTU
REWRITTEN UI FOR LINUX 1 4.1 0 D EDICATED I MAGES
CLIENT
ropbox, a client for an online FOR APPLE H ARDWARE

D

service that lets you bring all
your photos, docs, and videos
anywhere, has been promoted to
version 2.1 1 .34 for the

4

U

buntu 1 4.1 0 (Utopic Unicorn)
has been available for a
couple of weeks and the reception
has been positive for the most
part, but there is one small piece of
contents ^

NEWS

interesting information that didn't
get revealed. It looks like the
Ubuntu devs don't need to build
specific images for Apple
hardware.
Many Ubuntu users will
remember that, until the launch of
Ubuntu 1 4.1 0, there was an image
of the OS available labeled
amd64+mac, which was technically
aimed at Apple hardware.

the developers now have
applications that work both on the
mobile and on the desktop
platform without any major
modifications. One such example is
the Ubuntu Touch Music App,
which looks and feels native on
both operating systems.

Getting-Closer-464595.shtml
Submitted by: Silviu Stahie

an already switched to a more
powerful and secure operating
system of their own.

CHINA STARTS WINDOWS
WIPE-OUT, SWITCHES TO
LINUX

Source:
http://www.deccanchronicle.com/1
41 1 01 /technologylatest/article/china-startswindows-wipe-out-switches-linux
Submitted by: Arnfried Walbrecht

C

hina is presently in a situation
to completely eradicate
Windows from the country. Though
this is not immediately possible,
the map to wipe-out the Windows KRITA D ESKTOP: A FREE,
operating system from every
computer is planned over a period OPEN SOURCE PAINTING
of a few years from now.
TOOL, MAYBE AS GOOD AS

For now, Canonical is working
on Ubuntu for phones and Ubuntu
for desktop. Before long, however,
the projects will be folded into a
The Ubuntu devs marked this
single one, probably in a couple of
interesting evolution in the official years. Until then, the biggest
announcement for Ubuntu 1 4.1 0,
change that we’re seeing due to
but it went largely unnoticed.
this convergence policy is the fact
that applications for Ubuntu Touch
According to a report on
Source:
don't really have a problem running SoftPedia, China has planned to
http://linux.softpedia.com/blog/Ca on the desktop.
move away from Microsoft
nonical-Drops-Ubuntu-1 4-1 0Windows completely. Recently,
Dedicated-Images-for-AppleThe Ubuntu Touch Music App
China had announced the ban of
Hardware-4641 74.shtml
2.0 is the same as the one you can
Windows 8 in the country accusing
Submitted by: Silviu Stahie
find on the mobile platform, but
Microsoft of spying the China
there are some perks if you run it
government and businesses via the
on the desktop. Users can resize it operating system.
work much more easily with
U BUNTU TOUCH M USIC APP and
the playlist, which is a nice thing to
China has made it mandatory to
I S PROOF THAT TOTAL
have. In any case, it only runs on
all organizations to switch from the
U BUNTU CONVERGENCE I S Ubuntu 1 4.1 0 (Utopic Unicorn), so Microsoft Windows operating
system to a locally developed
G ETTING CLOSER – G ALLERY that's the only way to test it.
operating system based on Linux.
hile other platforms like
Source:
Windows or iOS are still
China believes that by the year
working towards their convergence http://news.softpedia.com/news/U
buntu-Touch-Music-App-Is-Proof2020, they will successfully
goal, Canonical is already there and
that-Total-Ubuntu-Convergence-Is- eradicate Windows and would have
full circle magazine #91
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PHOTOSHOP

I

f you do any graphics work you
should take a look at Krita
Desktop, a really impressive
painting tool that rivals Adobe
Photoshop for features and makes
some ways of working much easier.
Available as free, open source
software for Windows (Vista, 7, 8) ,
Linux (Ubuntu, Mint, Debian, and
others) and OS X (the site only
refers to 1 0.9 compatibility but I
ran it under 1 01 .1 0 without
problems). Krita Desktop is also
available in two paid-for variants:
Krita Studio and Krita Gemini.
First impressions: Way cool,
contents ^
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definitely worth checking out.
Source:
http://www.networkworld.com/art
icle/2841 804/software/kritadesktop-a-free-open-sourcepainting-tool-maybe-as-good-asphotoshop.html
Submitted by: Arnfried Walbrecht

LINUX FOUNDATION : O PEN
SOURCE IS EATING THE
SOFTWARE WORLD

I

n every sector of the technology
world there is now an open
source project that is defining that
particular technology. Software
drives value in nearly every
industry, and open source projects
are where most of that value
comes from.
That’s according to Jim Zemlin,
executive director of the Linux
Foundation and one of Monday’s
keynote speakers at this week’s
OpenStack summit in Paris – the
first in Europe. “Open source is
really eating the software world,”
Zemlin said, adapting the famous
phrase from a 201 1 Wall Street
Journal OpEd by venture capitalist
Mark Andreessen, titled Software
is eating the world.

There is a wholesale shift in the
enterprise software world from
using a little bit of open source
code here and there to an 80-20
split, where 80 is the open source
portion, he said. The reason for the
shift is quite simple: software has
become a way for an enterprise to
add value, and open source is the
best way to use a lot of software.
“There is too much software being
written for any organization to
write that software on their own,”
Zemlin explained.
Source:
http://www.datacenterknowledge.
com/archives/201 4/1 1 /03/linuxfoundation-open-source-eatingenterprise-software-world/
Submitted by: Arnfried Walbrecht

G OOGLE CLOUD ADDS
SUPPORT FOR U BUNTU
LINUX D ISTRIBUTION

G

oogle partnered with
Canonical to bring official
Ubuntu images to Google Compute
Engine.
Google Compute Engine
became generally available in
December 201 3. Since then, it
full circle magazine #91

added support for CoreOS, Debian,
Red Hat Enterprise Linux, SUSE and
Microsoft Windows Server. Though
Debian and Ubuntu distributions
are compatible, many developers
prefer to work on Ubuntu.
According to Canonical, Ubuntu
powers 85% of Linux workloads
running on public clouds. Ubuntu is
a popular choice of Linux
distribution on Amazon EC2,
Microsoft Azure and HP Cloud and
Joyent.
According to a blog post from
Google Cloud Platform team,
Canonical maintained images are
continually tested and updated,
following Ubuntu’s best-practices.
Source:
http://www.infoq.com/news/201 4/
1 1 /google-cloud-supportsubuntu?utm_campaign=infoq_cont
ent&utm_source=infoq&utm_medi
um=feed&utm_term=global
Submitted by: Arnfried Walbrecht

U BUNTU GNOME 1 4.1 0:
U NIFYING THE LINUX
DESKTOP

A

unsure why this happened, it's
simple -- Ubuntu is in a state of
holding because of Unity 8/Mir.
Until that happens, Ubuntu version
upgrades will be about bug fixes
and not much more. It makes
sense... why dump a bunch of
time/effort into an interface that's
about to undergo a radical shift?
However, that's not the case for
the GNOME flavor of Ubuntu.
Ubuntu GNOME 1 4.1 0 was released
along with the official flavor and
brings to light some really
impressive features. This release
also includes the much anticipated
GNOME-Maps and GNOMEWeather -- and it's important to
developers, because it comes with
numerous new APIs and widgets.
Source:
http://www.techrepublic.com/articl
e/ubuntu-gnome-1 4-1 0-unifyingthe-linux-desktop/
Submitted by: Arnfried Walbrecht

CANONICAL CONFIRMS
I NVOLVEMENT IN U BUNTU
LINUX TABLET

A

ccording to emails from
s you may know, Ubuntu 1 4.1 0
Andrew Bernstein, who has
came out with about as much emerged as the public face of the
fanfare as growing grass. If you're UT One tablet project, Canonical

6

contents ^

NEWS

"certainly will be involved" in the
production of the tablet, which will
feature an Intel x86 processor.

LINUX STILL OWNS
SUPERCOMPUTING

T

hat's no surprise. For years,
Linux has dominated
For now, Bernstein is holding his
supercomputing. The November
cards close with regard to
specifying exactly what Canonical's 201 4 Top 500 supercomputer
role will be. But he writes that, at a ranking found 485 out of the
world's fastest 500 computers
minimum, "we do hope to get
official hardware certification and running Linux. That's 97 percent for
some agreement on support for UT those of you without a calculator at
hand.
One's software, as in providing
support for end users in relation to
Compared to that, Windows on
the hardware."
desktops and Android on
smartphones are pikers.
Bernstein also confirmed that
Linux has grown to own
the tablet hardware will be ready
supercomputing since it first
to ship by December, although he
expressed doubt that the software appeared on the Top 500 list in
June 1 998 because it simply works
it needs to run will be available
well in creating ultra-fast
that soon. That's because
computers. Unix, which once
Canonical likely won't complete
work on Ubuntu Touch, the version dominated the bi-annual listings is
down to a mere 1 3 systems, 2.6
of Ubuntu that it is building for
percent. The remaining two
tablets, phones and other mobile
devices, until some time in the new supercomputers consists of a
system running a mixed operating
year, postponing the UT One
system and a single Windows
released, Bernstein said.
system.
Source:
http://thevarguy.com/ubuntu/1 1 06 Source:
http://www.zdnet.com/linux-still1 4/canonical-confirmsowns-supercomputinginvolvement-ubuntu-linux-tablet
Submitted by: Arnfried Walbrecht 7000035876/
Submitted by: Arnfried Walbrecht
full circle magazine #91

PROMINENT DEVELOPERS
PULLING OUT OF D EBIAN AS
VOTING DEADLINE NEARS

F

our prominent members of the
Debian community have
stepped down or reduced their
involvement in the project as a
result of an increasingly bitter
argument over the future of the
widely influential Linux
distribution.

Source:
http://www.infoworld.com/article/
2849364/linux/prominentdevelopers-pulling-out-of-debianas-voting-deadline-nears.html
Submitted by: Arnfried Walbrecht

CROWDFUNDING J OLLA, A
GNU/LINUX-POWERED
HIGH -SPEC TABLET

I

t runs an OS called Sailfish that
can use Android apps as well its
The battles center on the recent
own native apps, and was created
decision by Debian's governing
technical committee to replace the by a team with a bunch of senior
venerable sysvinit startup module Nokia refugees on it.
with systemd in the forthcoming
The tablet itself is super highrelease, dubbed "Jessie." Systemd
spec
and competitively priced (and
is a more sophisticated, complex
total vapourware at this point,
piece of software, which
caveat emptor). The OS is built on
supporters say is a necessary
GNU/Linux with the Qt application
update to a badly outmoded part
of Debian, while critics accuse it of framework. The company
advertises itself as privacy-friendly
being needlessly complex and
and promises never to sell or share
suffering from serious feature
your data and not to build in any
creep.
intentional back-doors.
The criticism has hit a fever
I took a flutter and pre-ordered
pitch in recent months, with
one.
systemd creator Lennart
Poettering taking to Google Plus to
talk about receiving death threats Source:
http://boingboing.net/201 4/1 1 /1 9/
and other online abuse.
crowdfunding-jolla-a-gnulinu.html
Submitted by: Arnfried Walbrecht
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H OW THE LINUX
FOUNDATION ' S CII I S
SECURING THE I NTERNET

T

he Heartbleed flaw that was
first publicly disclosed in April
of this year, was in some respects a
black eye on the open-source
community. Heartbleed is a flaw in
the open-source OpenSSL
cryptographic library that had wide
ranging impact across the
infrastructure of the Internet. In
the aftermath of Heartbleed, a
new effort emerged called the
Core Infrastructure Initiative (CII)
to help fund developers wanting to
improve security across critical
open-source infrastructure
technologies. In a video interview
with eWEEK, Jim Zemlin, executive
director of the Linux Foundation,
explains how CII works and what
can be done to improve opensource security. Zemlin noted that
in the case of OpenSSL, though it
plays a critical role in Internet
infrastructure, it was not receiving
the level of support that is
commensurate with the role it
plays. There are other open-source
efforts beyond just OpenSSL that
could also benefit from increased
financial support, he added.

Source:
http://www.eweek.com/security/h
ow-the-linux-foundations-coreinfrastructure-initiative-is-securingthe-internet-video.html
Submitted by: Arnfried Walbrecht

many more file types, including
archives, images and PDF. That’s
because, on these systems, less is
extended through a script called
lesspipe that relies on different
third-party tools to process files
with various extensions.

Source:
http://www.pcworld.com/article/2
851 692/less-means-more-toMALWARE AUTHORS
malware-authors-targeting-linuxTARGETING LINUX USERS
sing the “less” Linux command users.html
Submitted by: Arnfried Walbrecht
to view the contents of files
downloaded from the Internet is a
dangerous operation that can lead
ANTARCTIC ICE MIGHT BE
to remote code execution,
according to a security researcher. THICKER THAN PREVIOUSLY

'LESS' MEANS MORE TO

U

At first glance, less appears to
be a harmless command that
outputs a file’s content to a
terminal window and allows the
users to navigate forward and
backward through it. Less does not
allow file editing, which is a job for
file editors like the widely used vi,
but has the benefit of displaying
data on the fly without needing to
load an entire file into memory.
This is useful when dealing with
large files. Less is frequently used
to view text files, but on many
Linux distributions, including
Ubuntu and CentOS, it supports
full circle magazine #91

The robot runs on a 1 .2GHz Intel
Pentium processor and uses
Ubuntu, while the hull of the sub
has been so designed that it stays
stable enough for photographic
work, to allow the sonar to aim
precisely and to be able to send the
data thus collected consistently.
Source:
http://thewestsidestory.net/201 4/
1 1 /25/21 794/antarctic-ice-mightthicker-previously-thought-revealslinux-powered-underwater-robotseabed/
Submitted by: Arnfried Walbrecht

THOUGHT, REVEALS LINUX
POWERED UNDERWATER
ROBOT SEABED

S

eaBED, a submersible robot
powered by Linux, was recently
used to scan the huge frozen ice
sheets across Antarctica. That has
helped scientists get detailed and
high-resolution 3-D maps of the
frozen continent for the first time.
Researchers at the British Antarctic
Survey will now be able to know
more regions which had earlier
been difficult to access because of
the hostile conditions prevailing in
the area.
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C O M M AN D & C O N Q U E R

L

J eet & Em m et

Written by Lucas Westermann

ast month I mentioned the
Zurb Foundation when
discussing bower. For a long while
it was my go-to grid system,
regardless of my opinion towards
using divs for rows and the strict
formatting guidelines. Very
recently, however, I have found a
new framework which does not
require those sorts of divs (or even
pre-defined classes). It is called
Jeet, and after using it on only one
project, I don’t see myself using
Foundation for the grid any more.

EXAMPLE FILES

Further Reading (below) does an
excellent job describing what
exactly Jeet is. So instead, I will
focus on an example of how it
differs from Foundation.

This generates the basic HTML5
page structure (doctype, html tags,
head and body).
link[href=”css/foundation.css
”]:css

This generates a <link
rel=”stylesheet”
EMMET? WHO?
href=”css/foundation.css”> line.
Replace foundation.css for app.css
Emmet is essentially the
spiritual successor to Zen Coding. It for the Jeet example
enables you to enter a series of
header+section>article+aside^
selectors (based off the CSS
footer
selectors), which then autoThis creates a set of header tags,
completes into HTML code when
followed by (“+” adjacent sibling
you hit tab. There are plugins
selector) a section element with
available for the vast majority of
two children (“>”, an article and an
text editors, so you should have no aside), and then a following (“^" up
problem finding one.
one level) footer tag.

I’ve created a github repository
containing all my example files. For
anyone interested in them, they
THE EMMET EXAMPLE
can either be viewed on the web,
or cloned. The repository is here:
For the illustration between the
https://github.com/lswest/FCM91 . differences of Jeet and
Foundation, I will use the same
three statements in Emmet, and
J EET - WHAT IS IT?
work from there. After each
statement, I’ll hit tab and have
Jeet is a so-called “Ratio Grid”.
emmet complete it, then move
It features functions in SASS or
onto the next. They are:
Stylus to generate the CSS
required to create columns on any
html:5
element. The website linked to in
full circle magazine #91

After running these commands,
I will have a basic HTML5 page. To
see what the end result was, look
in the emmet.html file in the
example code.

THE EXAMPLE

Foundation:
• Create a div with class “row”
within the body tags.
• Create an extra style to expand
the width of the row to 1 00%.
• Add your column classes to every
element.
• Add a div with class “row” around
the article and the aside elements
within section.
The same steps for Jeet
(starting after the emmet file was
created):
• Run the cf() function on header,
footer and section (Not strictly
necessary, but it definitely doesn’t
hurt).
• Run the column function on
article and aside (col(0.75) and
col(0.25) respectively).
• Compile the scss or stylus file.
In both cases, I’ve added a few
extra styles to help illustrate the
end layout, but as they aren’t
necessary, I haven’t included them.

Note : The functions for Jeet can
Assuming you wanted to create
a two-column layout that spans the be run in scss, but that requires the
whole width of the webpage, you’d format @include col(0.75); The
format I use above is for Stylus.
need to do the following for
9
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Note #2 : If you want to work on aspects, as it offers more than just

the stylus file, you’ll first need to
install jeet (most easily done via
npm).

PYTHON SPECIAL EDITIONS:

a grid (such as pre-defined styles
for buttons or menus), and it can
easily be mixed with the Jeet grid.

Final note : If you want Jeet to
work in older versions of Internet
Explorer, you’ll need to use
As you can see, the
something like selectivzr,
configuration of the columns
modernizr, or HTML5shiv, or a
occurs in a stylesheet, meaning you combination.
can focus on creating a basic html
structure, and then only edit it as
I hope this article has been
you add extra styles that you may
helpful to anyone starting out with
need. You’re not forced to adjust
web programming. If you have any
the columns by editing the element questions, or have used either
tags, which is great when you’re
Emmet or Jeet for an interesting
working with a CMS and won’t
project, feel free to email me at
necessarily be able to easily edit an lswest34+fcm@gmail.com. Also,
HTML file to make your changes.
anyone who has a request for an
Another benefit is that the
article is also welcome to email me.
compiled CSS file contains literally
only the styles you use. While
FURTHER READING
Foundation does let you pick and
choose different modules to
compile, there is very often a large http://jeet.gs/ - The Jeet
Framework
amount of unnecessary code.
https://github.com/mojotech/jeet/
tree/master/stylus - The Jeet
Hopefully this will help bring
Jeet to the attention of those just Framework Stylus github
repository with useful stylus
starting out, so they can focus
projects (listed under Protips).
more on good formatting and
http://emmet.io/ - The Emmet
being succinct rather than
conforming to the Zurb Foundation website
https://github.com/lswest/FCM91 format. That isn’t to say
Foundation isn’t useful for certain Github repository with examples.
full circle magazine #91

THE CONCLUSION

http://fullcirclemagazine.org/issue-py01 / http://fullcirclemagazine.org/issue-py02/

http://fullcirclemagazine.org/pythonspecial-edition-issue-three/

http://fullcirclemagazine.org/pythonspecial-edition-volume-four/

http://fullcirclemagazine.org/pythonspecial-edition-volume-five/

http://fullcirclemagazine.org/pythonspecial-edition-volume-six/
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H O W-TO

Written by Greg Walters

CROSS STITCH PATTERN
G ENERATOR - PART 4 U NDERSTANDING PYFPDF

P ro g ra m I n P yt h o n P t . 5 7
The origin of the page is the upperleft corner, and the current
position defaults to 1 cm from the
margin. The margin can be changed
with the SetMargins function.

border(default)), 1 is border, or a
string of any or all of the following
characters: "L","T","B","R"
• Line is where the current position
should go after printing the text.
orry for missing so many
Values are 0 (to the right), 1 (to the
months. I still can’t sit for long
Before you can actually print
beginning of the next line, 2
periods of time, so this article
any text, you must call
(below). Default is 0, and putting 1
might be shorter than what you are
pdf.set_font() to define a font. In
is equivalent to putting 0 and
used to. My original plan was to
the
line
above,
we
are
defining
calling ln() immediatly after.
If you need to use ‘US’
jump right into the PDF output
standards, you could do it this way: Arial Bold 1 6 point. Standard valid • Align allows to center or align the
portion of the program, but there
fonts are Arial, Times, Courier,
text within the cell. Values are "L"
is so much to understand about
Symbol and ZapfDingbats.
(left), "C" (center), "R" (right).
pdf=FPDF(‘P’,’in’,’Letter)
this library, I decided to use this
• Fill sets the background to be
installment as a tutorial on pyfPDF
Now we can print a cell with the painted (true) or transparent
Notice the parameters are
and then tackle the PDF output
pdf.cell() call. A cell is a rectangular (false). Default is false.
FPDF(orientation, units, format):
next time. So let’s get started.
• Link is a url or identifier returned
• Possible values for orientation are area, possibly framed, which
contains
some
text.
Output
is
at
by addlink().
“P” for Portrait and “L” for
FPDF stands for Free PDF. A
the current position which is
Landscape.
VERY minimal example would be as • Possible values for units are: ‘pt’
specified (40,1 0 cm) in the above
Finally, the document is closed
follows:
example. The parameters are:
and sent to the file with Output.
(poiints), ‘mm’ (millimeter), ‘cm’
The parameters are
(centimeter), ‘in’ (inches).
from fpdf import FPDF
pdf.cell(Width, Height, text, fpdf.output(name,dest). If file is
• Possible values for format are:
border, line, align, fill,
not specified, the output will be
‘A3’, ‘A4’, ‘A5’, ‘Letter’, ‘Legal’ or a
pdf = FPDF()
link)
sent to the browser. Options for
tuple containing the width and
pdf.add_page()
destination are "I" (inline to
height expressed in the unit given
Where:
in the unit parameter.
pdf.set_font(‘Arial’,’B’,16)
• Width is length of cell. If 0, width browser(default)), "F" (local file
given by name), "D" (to the
extends to the right margin.
pdf.cell(40,10,’Hello From
browser and force a file download
The third line creates a page to • Height is the height of the cell.
Python’)
enter data into. Notice a page is
• Text is the string of text you want with the name passed), and "S"
pdf.output(‘example1.pdf’,’F’ not automatically created when we
(return the document as a string).
to print.
)
create the instance of the object.
• Border is either 0 (no
full circle magazine #91
11
contents ^

S

The first line imports the library
file. The next creates an instance of
the FPDF object. We use the
default values for this example,
which are:
• Portrait
• Measure Unit = Millimeters.
• Format = A4

HOWTO - PROGRAM IN PYTHON
Since we will be sending our
cross stitch images to the pdf file,
we will have to understand the
image function.
The function is called like this:

FPDF prior to 1 .7, Alpha channel is
not supported.
I stole this example (shown
right) from the pyFPDF tutorial.

You have been around long
enough that you should be able to
look at the program and
understand what is going on. But in
This function puts the image.
The size it will take on the page can this example the line we are
REALLY interested in is the fourth
be specified in different ways:
line:
• Explicit width and height or
• One explicit dimension
this.image('img1.png',10,8,33
pdf.image(name,x=None,y=None,
w=0,h=0,type="",link="")

)

Supported formats are JPEG,
PNG, and GIF. If you wish to use GIF
In this instance, we are calling
files, you must get the GD
the image function with the
extension.
filename, the x position of where
the picture will go on the page, the
For JPEGs, all flavors are
y position, and the width of the
allowed:
picture.
• gray scale
• true colours (24 bits)
Now that you have a gross
• CMYK (32 bits)
grasp of the library, we will start
our PDF code next time.
For PNGs, the following are
allowed:
Until then, have a good month.
• gray scales on at most 8 bits (256 See you soon.
levels)
• indexed colors
• true colors (24 bits)

from fpdf import FPDF
class PDF(FPDF):
def header(this):
# Logo - replace with a small png of your own
this.image('img1.png',10,8,33)
# Arial bold 15
this.set_font('Arial','B',15)
# Move to the right
this.cell(80)
# Title
this.cell(30,10,'Title',1,0,'C')
# Line break
this.ln(20)
# Instantiation of inherited class
pdf=PDF()
pdf.alias_nb_pages()
pdf.add_page()
pdf.set_font('Times','',12)
for i in range(1,41):
pdf.cell(0,10,'Printing line number '+str(i),0,1)
pdf.output('example2.pdf','F')

Greg Walters is owner of RainyDay

Solutions, LLC, a consulting company
in Aurora, Colorado, and has been
programming since 1 972. He enjoys
cooking, hiking, music, and spending
time with his family. His website is
www.thedesignatedgeek.net.

Note : interlacing is not allowed,

and if you are using a version of

full circle magazine #91
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Written by Elmer Perry

preadsheets are good for
collecting data like
temperatures, stock prices, and
sports data. However, the data on
its own does us little good. We
need ways to analyze the data.
LibreOffice Calc provides us with
built-in functions to do this. In this

Li breO ffi ce Pt.43 - Sta ti sti ca l Fu n cti on s
article, we will look at a few of the
simple statistical functions built
into Calc. This is not meant as a
thorough examination of all the
functions, but more an exercise to
get you comfortable using
functions.

I MPORTING THE D ATA

Throughout this article we will
use the prices as our data range.
Since we will use the range several
For our data, I have collected a
times, we will name it to make the
few months worth of stock prices
on the mutual fund FFACX. You can references easier. Select all the
prices (cells B2:B82). The easiest
find the data at
way to select all the cells is to type
http://pastebin.com/AeLcyM1 t.
the range B2:B82 into the cell
The data is laid out as commadelimited plain text. Copy the data name box on the formula toolbar
from Pastebin. Make sure that you and press Enter on the keyboard.
Insert > Names > Define, and the
copy from the ”Raw Paste Data”
“Define Name” dialog shows. Name
text box. Create a new Calc
the range “Prices”. Notice the
document. Right-click on cell A1
absolute reference in the Range
and select Paste. The Text Import
text box ($Sheet1 .$B$2:$B$82).
dialog will show. Under Separator
Options, select “Separated by” and Names apply to a specific group of
cells, so the reference is absolute.
check Comma. Click OK. You now
have two columns of data, the date Under the Scope, we will restrict
the use of this name to just Sheet1 .
and the price. Save the sheet.
Click Add to create the range
name.

CREATING A N AMED CELL
RANGE

Now, in any formula or function
where we use the name “Prices”, it
is the same as typing the cell range
$Sheet1 .$B$2:$B$82.

MAX AND MIN
full circle magazine #91
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The first two statistical
functions we will look at are MAX
and MIN. Both functions accept a
contents ^
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list of values or range(s). MAX
returns the maximum (or largest)
value in the list. MIN does just the
opposite, returning the minimum
(or smallest) value in the list.

Move your cursor to D4. Type in
“Highest.” In the cell E4, type in the
formula
=MAX(Prices)

You should get the result 1 4.1 6.
If you look through the list of
prices, you will discover this is the
largest number in the list.
In D5 put “Lowest.” The formula
for E5 is
=MIN(Prices)

The result is 1 3.57, the lowest
number in the list.
It is also possible to use these,
or any Calc function, as an operand
in a formula. For example, if we
wanted to know the difference
between the highest and lowest
price, we could use the formula
=MAX(Prices) – MIN(Prices)

in cell E6. In the formula, the
results of the functions are

calculated first. MAX(Prices)
becomes 1 4.1 6, and MIN(Prices)
becomes 1 3.57. Then the result of
1 4.1 6-1 3.57 is placed in the cell E6.
Place the text “Difference” in the
cell D6 as a label.

AVERAGE, MEDIAN,
AND MODE
In statistics there are many
ways to determine just what is the
typical value for a set of numbers.
Among these are the arithmetic
average, the median, and the
mode. The arithmetic average,
known to most people as simply
the average, is the sum of a series
of numbers divided by the number
of items in the series. In Calc we
use the AVERAGE function to get
the arithmetic average.
The median ranks the numbers
from the lowest to the highest. If
the number of items in the series is
an odd number, it takes the one in
the middle. If it is even, the median
is the arithmetic average of the
two center numbers. Calc uses the
MEDIAN function to calculate the
median for you.
Mode is the number that
repeats most often. If there is a tie,
full circle magazine #91

it uses the smallest number. Calc
uses the MODE function to get the
mode for you.
We can see the results of these
three functions by putting the
following formulas in the cells E7,
E8, and E9.
=AVERAGE(Prices)
=MEDIAN(Prices)
=MODE(Prices)

You will notice that the results
are within a few hundredths of
each others. This is not true in all
cases. Numbers that are much
larger or much smaller than all the
others can affect the average. In
those cases, the mode or median
might better suit your needs for a
typical value.
The Calc statistical functions
help us to analyze the data in a Calc
spreadsheet. We touched on only a
few of the statistical functions.
Calc has over 70 statistical
functions. This is just one of many
categories of functions available to
us in Calc. You can get a list of all
the Calc functions in the help
documentation.
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CONDITIONAL FORMATTING

In our data set, the top and
bottom are pretty close together,
so the average will work good for
us as the typical value for this data
set. We can use conditional
formatting to mark each of the
prices as either above or below the
average.
Start by selecting all the prices
in the B column (B2:B82). Since we
named the range B2:B82, a quick
way to select all the prices is by
using the drop down arrow for the
cell name box on the formula
toolbar and selecting the name
“Prices(Sheet1 ).”
Format > Conditional
Formatting > Condition will bring
up the Conditional Formatting
dialog. Select “Cell value is” from
the left drop-down list. From the
drop-down list in the center, select
“less than.” Enter $E$7 in the text
box to the right. If you want to use
the median or mode for the
contents ^
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comparison, you can use $E$8 or
OK to save the new style.
$E$9. We are using an absolute
reference here because we want to
OK in the Conditional
reference the same cell regardless Formatting dialog will save the
of what row we are formatting.
settings. Prices that are over the
average will highlight in green, and
For the Apply Style, select “New the prices below the average will
Style” from the drop-down list. The highlight in red.
Cell Style dialog will open. On the
Organizer tab, name the style
NOTE: You can create your style
“Below Average.” Switch to the
for conditional formatting before
Background tab and select the Red creating the condition. In such a
color swatch. Click OK to close the case, you would just select the
dialog and save the new style. You style to use.
will see “Below Average” is now
selected as the Apply Style.
I hope this article has helped
you to understand the use of the
Click Add to add a second
statistical functions demonstrated
condition. This time select “greater and functions in general. We saw
than” instead of “less than.” Use
how to use named ranges to
the same absolute reference, $E$7, identify cell ranges being used
$E$8, or $E$9, as you used in the
repeatedly. We used functions by
less than condition. Once again
themselves and as operands in a
select “New Style” for the Apply
formula. Using conditional
Style. Give the new style the name formatting, we highlighted certain
“Above Average”, and make the
cells to show visually the status of
background green instead of red.
the cell's value. This eliminates the
full circle magazine #91

need to scroll back up the sheet to
check the average value. Until next
month, look up some functions in
the help and put them to work for
you. Also, play with some of the
features of the conditional
formatting and see what other
visuals you can create.
Next time, I will show you how
to validate cell values.

EXTRA! EXTRA!
READ ALL ABOUT IT!
Our glorious news reporters
are now posting regular news
updates to the main Full Circle
site.
Click the NEWS link, in the site
menu at the top of the page,
and you'll see the news
headlines.
Alternatively, look on the right
side of any page on the site,
and you'll see the five latest
news posts.

Elmer Perry's history of working, and
programming, computers involves an
Apple ][E, adding some Amiga, a
generous helping of DOS and
Windows, a dash of Unix, and blend
well with Linux and Ubuntu.
He blogs at
http://eeperry.wordpress.com
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Feel free to discuss the news
items. It's maybe something
that can spill back from the site
into the magazine. Enjoy!
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Written by David Mawdsley

and simplicity of its method. (I
firmly believe that most users fail
to use encryption because of this.)
I'm sure you'd tell me about the
advantages of pgp or gpg
public/private keys, but I needed
MY PASSWORD LISTS
Encrypted files get the
something that makes encrypting
extension .cpt to indicate
and decrypting files as dead-simple
First, my script runs a quick
as possible, and with a reasonable
check to see if the caps lock key is encrypted status. All activity
regarding
encryption/decryption
of
level of security. ccrypt uses a
enabled on my keyboard so that I
password files is then logged into
simpler symmetric key instead.
am certain that my master
password is correctly typed though the file 'pwlog.' for recording my
password file access activity. Note
I imagine that malicious hackers
it doesn't display as I type.
H OW I STORE MY
that removing the '.cpt' extension trying to get personal information
PASSWORDS
doesn't undo the encryption.
about me or my files always go for
Next, control goes through a
my low hanging fruit on my
decryption routine resulting in
My passwords all reside in
My script also allows me to
document tree first, and then
opening the clear-text file in my
encrypted text files on my
navigate
to
and
encrypt
or
decrypt
maybe even never bother with the
choice Linux text editor gedit –
computer, and also as non-linked,
delicious higher fruit (where my
where I can read the clear-text file any chosen file on my computer.
encrypted text files on my
The encryption utility I use is
encrypted files are).
of passwords with accompanying
website's hosting server. Here’s my details.
ccrypt, it’s available from most
rationale: I am able to easily
standard repositories via:
You might appreciate what an
decrypt any file into clear text
encrypted text file using ccrypt
I then close that clear-text file
sudo
apt-get
install
ccrypt
when needed on my regular
actually looks like. Bring it up with
after seeing what I need. The utility
computer whereby I can ...
extension .cpt in your text editor;
then continues and processes the
Notes
on
ccrypt
can
be
found
at:
• Use it on a day-to-day basis, and
you will quickly realize that
encryption – thereby converting
http://ccrypt.sourceforge.net/#des
•Save it to a USB key in a safe
decrypting that file using trial and
the clear-text file back to its
cription
which
describe
fully
how
to
deposit box using clear-text that
error, anti-encryption software just
encrypted form and then it saves
use
it.
gets rotated every 1 5 days—my
isn't a short-time possibility for
the result.
regular business practice.
anyone trying to break your
I
chose
ccrypt
based
of
its
ease
(Encrypted files would be quite
encryption. However, I always
Lastly, my script lists the folder
of
use
and
the
overall
quickness
safe to store even on a cloud
assume that NO encryption will
of encrypted files (I have many in
full circle magazine #91
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use a Terminal Bash script to
interact with my encrypted
password files as needed. My script
procedure is simple and quick. A
person new to Bash scripts should
see them as small, self-contained,
utility programs which use the full
power of Linux and make
repetitive, perhaps tedious,
difficult tasks much easier to
accomplish.

storage service.)

M u l t i p l e P a s s wo rd s W i t h A S c ri p t

my actual business), showing the
file and its extension as encrypted
to verify that the encryption
H OW I MANAGE MY
actually was successful with the
ENCRYPTION /DECRYPTION OF clear-text file now gone.

HOWTO - MULTIPLE PASSWORDS WITH A SCRIPT

resist persistent breakage forever.
Thus, my method is practical
without being fool-proof.
Remember the low hanging fruit
principle.

Make your ccrypt default
password difficult to guess and
you're probably protecting
yourself very well. (1 1 + password
characters or more with nondictionary words, upper/lower case
letters, numbers and punctuation)
Example:

The script presents a directory
of 4 choices and an exit option.
Entering 1 , 2, 3, 4 or 0 sends script
control to the relevant selection. I
particularly like to use colors in my
scripts so that the presented dialog
and responses stand out. While I
normally heavily comment my
scripts, I suspect that most readers
will have little trouble following
the flow. A run of the script usually
clears up the remaining user/coder
uncertainties.

Below I've included a
modification of my Bash script so
that you can easily convert it to
your computing environment.
Make it executable via owner for
your computing needs with:

wrapped around.

SCRIPT
http://goo.gl/ockJEj

chmod u+x <filename>

Note that I always use indents
even in Bash scripts to improve
readability and that long lines
shown here may display as

mYbroTher#owEmE400$

THE SCRIPT
The script resides in my home
directory with the terminal
command of ./dirpw to start it. My
'pw' folder with password files
resides on my Desktop folder 'pw.'
In that folder are my encrypted
text files: 'customers.cpt 'and
'personal.cpt' – that contain
relevant webpage control panel
login details, e-mail security
questions, etc. All activity
regarding encryption/decryption of
files is also logged into the file
'pwlog.' for recording passwordfile accesses.
full circle magazine #91
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Written by Mark Crutch

fter the previous instalment
of this series had gone to
press, an interesting problem was
raised at www.inkscapeforum.com
that directly relates to the use of
unset fills and clones. So, before
moving on to the next topic, I think
it's worth drawing attention to this
issue, and how you can deal with it.
Let us suppose that you create a
parent object and unset both its fill
and stroke. As you know from the
previous instalment, you can now
set the fill and stroke on any clones
independently. I demonstrated
using colors, patterns and
gradients for both the fill and the
stroke, but it seems that one thing
I missed was setting a non-opaque
color – i.e. one with the alpha (A)
channel in the Fill and Stroke
dialog set to something other than
255. It turns out that doing this
with the stroke works perfectly
well, but the opacity of the fill
color is completely ignored. In this
example you can see what I mean.
Both the fill and stroke opacities
on the clone have been set to 1 77,
but only the stroke actually
appears transparent (the bottom

diamond shows how the clone
should appear).

1 00%, there is a “fix” for the issue.
It will mean using Inkscape's XML
Editor dialog, which is a topic I had
hoped to avoid until later in this
series, but as my hand has been
forced, I've decided to introduce it
now. But to understand the XML
editor, you first need a little insight
into the structure of an Inkscape
file.

The SVG format that Inkscape
unset the opacity, making it default natively uses is an XML file,
It turns out that there's a bit of to the SVG standard of fully
meaning that it follows the rules,
a bug in Inkscape (issue 1 1 83400 in opaque. Clearly the parent at the
conventions and structure for such
Launchpad). When you unset a fill, bottom is still translucent, as the
files as defined by the W3C – the
the program fails to remove the
standards body of the web. XML is
blue bar behind it shows. Even
“fill-opacity” attribute in the SVG.
without the blue bar, it appears as a dubious abbreviation of
Any clones made from that object a washed out gray color, rather
“eXtensible Markup Language”. In
are then stuck with the opacity
short, it means that every Inkscape
than the deep black we would
that the parent fill had before it
file is made up of a hierarchical
usually expect of an unset fill.
was unset. As a demonstration of
collection of “tags” (also called
Furthermore, the clone is now
this, I created a clone and filled it
“elements” or “nodes”), each of
forced to adopt the transparency
with an opaque green color. Then I of the parent, so there's no way
which can carry “attributes” to
set the alpha channel for the green that any clones of this object could further define it. For example a
fill to 1 77. Next I unset the fill
be completely opaque, regardless simple rectangle might appear in
altogether. Finally I cloned the
an SVG document as a “rect” tag,
of their own alpha value.
object and gave the clone a fully
with attributes for defining its size
opaque purple color.
and location:
For most people this bug may
never be a problem, but if you do
<rect height="300"
What I would expect to see here want to set the opacity of your
width="400" x="50" y="100" />
is that unsetting the fill should also clones to be anything other than
full circle magazine #91
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What about the hierarchical
aspect I mentioned? How about
this more complex example:
<svg
xmlns="http://www.w3.org/2000
/svg">
<g>
<rect id="r1"
height="300" width="400"
x="50" y="100" fill="red" />

the canvas. The “r2” rectangle is
drawn afterwards, so it overlaps
the first one. The result is a simple
SVG image with a blue rectangle on
top of a red one, both inside a
group. Try it for yourself: copy the
code above into a text editor and
save it with an “svg” extension,
then load the file into a web
browser or Inkscape.

to get a feel for the structure of an
SVG document. Of course the ones
that Inkscape produces are far
more complex, generally including
many more elements and
attributes, but the basics remain
the same. If you want to take a look
at some more simple files in your
text editor then I recommend the
various flag images on Wikipedia,
which tend to be pared down and
minimised by hand, removing any
unnecessary structure or metadata.
Examining a few of these will
quickly give you some insight into
the structure of XML files.

What if we wanted another
rectangle, outside the group? We
could just include an additional
</g>
<rect> element but place it after
the opening <svg> tag but before
</svg>
the opening <g> tag. That would
put it behind the group when the
Let's switch back to Inkscape
As you can see, we've got two
image
is
rendered.
Place
it
after
now,
and create a very basic
rectangles now, and they've gained
drawing – just a single purple
a couple more attributes to set the the closing </g> tag, and before
rectangle on the canvas.
fill color, and to give each of them the closing </svg> tag, and it will
appear on top of the group. Give it
an ID so we can identify them
individually. Those are both inside a try for yourself, but remember to
change the position, size and
a set of <g>...</g> tags, which
colour of the new rectangle so that
defines a group in SVG terms. The
it doesn't get obscured by the
group, in turn, is inside the
existing ones. While you're editing
outermost pair of <svg>...</svg>
the file, how about adding “rx” and
tags. You can think of these as a
“ry” attributes to set the size of the
clue to an application that the
corner radius. Or replace the <rect>
content inside them should be
with a <circle>, swapping the
rendered as SVG, rather than as
dimension and position attributes
HTML or plain text.
for “cx”, “cy” and “r” to set the
center coordinates and the radius.
Because the “r1 ” rectangle is
first in the file, it's drawn first on
By now you should be starting
full circle magazine #91
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<rect id="r2"
height="500" width="100"
x="200" y="50" fill="blue" />

With your new found
knowledge of SVG you should
know how to hand-code this in just
three lines, yet, when I saved my
copy from Inkscape, the resultant
file had 62 lines in! Admittedly
many of these were due to it
putting every attribute onto its
own line – an option that can be set
in the SVG Output pane of the
Inkscape Preferences dialog. Yet,
even enabling the “Inline
attributes” setting still resulted in
1 9 lines. What's going on?
Look at an Inkscape SVG file in a
text editor and you'll quickly spot a
lot of attributes that have a prefix
to their names. So rather than
label="Layer 1 " you'll see
inkscape:label="Layer 1 ". This is a
feature of XML called
“namespaces”, and it's basically a
mechanism by which one XML file
can safely include elements and
attributes from other XML
languages without having to worry
about them clashing. In this case it
indicates that the “label” attribute
isn't part of the SVG spec, but is
rather an attribute from the
“inkscape” namespace. This allows
Inkscape to include applicationspecific data in a file, whilst still
remaining compatible with the SVG
contents ^
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specification, and therefore with
other applications that can read
SVG files (though they'll usually
ignore the Inkscape-specific
additions).

earlier. Whereas we used the
fill="red" syntax to provide a fill
color, Inkscape uses a more general
purpose “style” attribute to carry
numerous details about the color
and style of the rectangle. It also
In an Inkscape file, you'll
uses hexadecimal RGB numbers for
typically see “inkscape” and
the color, rather than a color name
“sodipodi” namespaces that are
– you can force it to use color
used to store application-specific
names where possible in the
data (Inkscape was created as a
Inkscape Preferences, but it's
fork of an older SVG editor called
usually not worth bothering with
Sodipodi – which was, itself, a fork unless you have a specific reason to
of an even older vector graphics
do so: most colors don't have
program). You'll also see “dc”
corresponding names so will still be
which stands for Dublin Core, and
stored as hex numbers, and using
represents the namespace for a set names can cause problems with
of defined terms used to contain
some Inkscape extensions.
metadata about the file. You can
set these using the File >
With all that background in
Document Metadata menu item in place, it's finally time to look at the
Inkscape, and it's recommended to file in Inkscape's XML editor. You
fill out at least some of the fields if can open this by pressing CTRLyou plan to distribute your SVG file SHIFT-X or by selecting Edit > XML
online. Because the metadata are
Editor from the menu bar. The
stored in a standard form using a
dialog is made up primarily of a
well known namespace, it increases tree on the left which shows the
the chance that your document
could one day be indexed by online
search engines.
One final thing to note in the
file is that the rectangle itself,
although it's pure SVG with no
namespaced attributes, is a little
different to the ones we created
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structure of the SVG file, and a
pane on the right to list and edit
the selected item's attributes. The
little triangles in the tree can be
toggled to show or hide that
particular part, and indentation is
used to show the hierarchy of the
elements. In this screenshot I've
expanded all the triangles so that
the metadata elements are visible,
with their Dublin Core namespace.
Despite the closing tags not being
explicitly shown, you can
nevertheless see that the rect at
the bottom is “inside” the group (g)
just above it – actually an Inkscape
layer, as you can tell from the
Inkscape-namespaced “label”
attribute. This layer is, in turn,
inside the root svg element. One
thing to note is that the XML Editor
shows the SVG namespace on
elements (so you can see svg:svg,
svg:g, svg:rect...) even though the
exported file just uses the base
names (in XML terms the SVG
namespace is set as the default for
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the document, so it doesn't then
need to be explicitly added to
every element).
When an entry in the tree is
highlighted, its attributes are
shown on the right. If a single
element or group is selected on
the canvas it will be automatically
selected in the XML Editor, so you
can simply leave the dialog open
and click on various objects in your
drawing to see their details.
Equally, selecting an entry in the
tree will also select the
corresponding object on the
canvas.
Here I have the rectangle
selected, but there's something
odd going on. If you look back at
the image of the rectangle on the
canvas you'll see that it has
dimensions of 400x300 pixels, and
is positioned at x=1 40, y=500. Now
look at the XML Editor image:
width, height and x are all correct,
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but y claims to be 252.3621 8 –
which is pretty far from 500!

selected, let's click on the “style”
attribute on the right. The
attribute name and value is put
SVG places its origin point at
into the fields at the bottom of the
the top left of the document. This dialog. In the case of the style
sort of makes sense, given that it
attribute, the value is actually a
comes from the world of the web
single long string which is, itself,
where the height and width of a
made up of name:value pairs. If
document can change dramatically, you're familiar with CSS from the
but the top left is always the top
web world, then you'll recognise
left. The x-axis therefore runs from the format – if not all of the
left to right, as you might expect,
property names (SVG uses a lot of
but the y-axis runs from top to
the standard CSS properties you
bottom, with positive values
might know from writing HTML,
moving further down the page.
but adds a few of its own). With the
Inkscape, on the other hand,
style attribute loaded for editing,
presents a more traditional
we can now address that pesky
drawing view, with the origin in the issue with the fill-opacity and
bottom left, and the y-axis running clones.
up the page from top to bottom.
So the 500 value you see in the
See the “fill-opacity:1 ;” section,
main Inkscape window represents right near the start? We need to
the distance from the bottom of
remove that. This is just a multiline
the page to the bottom of the
text field, so simply click to place
rectangle, whereas the value in the the cursor in there, then move
XML Editor (and the value that
around with the arrow keys and
appears in the SVG file) is the
edit the text as you would
distance from the top of the page normally. Once your editing is
to the top of the rectangle. Usually done, you need to click on the “Set”
this incongruity has little impact,
button to make it take effect.
but if you're trying to find specific Assuming the fill-opacity's value
coordinates in an SVG image you
was 1 , then you shouldn't notice
do need to be aware of the
any change, since 1 in here
difference.
corresponds to 255 in the Fill and
Stroke dialog, and is the default for
With the rectangle still
SVG if it's not specified.
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Now clone the rectangle, and
try changing the clone's color. You
can't, of course, since the parent
rectangle's fill is still purple, not
unset – but, once you give the
clone a fill color, you gain access to
the alpha slider in the Fill and
Stroke dialog. Reduce that value
and you'll see that you can affect
the transparency of the fill, if not
its color. Select the parent again
(SHIFT-D if the clone is still
selected) and then unset the fill.
Now you can change the clone's fill
color and opacity to your heart's
content. It's as simple as that: to
work around this Inkscape bug, and
restore the ability to change a
clone's fill opacity independently
of its parent, you just have to
remove the fill-opacity property
from the parent's style attribute.
Doing this on my original test
image gives exactly the result you
would expect.

You may have noticed that I
haven't talked about the toolbars
in the XML Editor, and that's with
good reason. The buttons there
give you the ability to significantly
change the structure of your SVG
file – potentially with disastrous
effects if you're not sure what
you're doing. By all means have a
play around in the XML Editor.
Move nodes, un-indent them,
change their attributes or remove
them altogether. It offers a
fascinating insight into the
structure of an Inkscape file, and
gives you unprecedented power to
tweak things that aren't always
exposed in the Inkscape user
interface. But if you do decide to
experiment, please make sure you
do it on a temporary file, or one
you've got backed up elsewhere.

Mark uses Inkscape to create three
webcomics, 'The Greys', 'Monsters,
Inked' and 'Elvie', which can all be
found at
http://www.peppertop.com/
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H O W-TO

Ard u i n o

Written by Ronnie Tucker

his month we’ll finish our first
major Arduino contraption. It’s
what I call the laser trip-wire. At the
moment, we can arm and disarm
the system, and our LDR can detect
the loss of the laser. Let’s add to it
with another component: the
buzzer.
Enter the code to arm it and
when the beam is broken the
buzzer will sound until either the
beam is restored, or the code is
entered to disarm it.

But first, we need the buzzer to
play something, and this is where
we add another library called
‘pitches’. Rather than creating a
new file and pasting in stuff, I
discovered a new way of adding a
library. Click the little down arrow
at the top right of the IDE window
and choose to create a new tab.
Paste your library text in there and
voila! You’re done.

I also added a new IF statement
to check (via the LDR) if the laser is
on/off:
if (sensorHit < 700 && armed
== 1){ //beep when armed &
beam broken
tone(buzzer,notes[3],200);
//beam broken play note 3
}

I found (via the serial window)
I acquired this ‘pitches’ text, and that the LDR registers about 600
when the LDR is not being hit by
new tab idea, from:
http://arduino.cc/en/Tutorial/Tone the laser. So, in my IF statement
and in the main loop, I’m saying: ‘if
I added some code to set things the system is armed and the LDR is
registering less than 700 the laser
up:
must be broken so sound tone 3 via
const int buzzer = A2;
the buzzer’.

repeating while statement to play
several tones to have a more
elaborate alarm/jingle.
Are there any similar projects
you’d like me to try? Drop me an
email at:
ronnie@fullcirclemagazine.org.
Remember: I’m a beginner, don’t
ask me to design the next NASA
rover!
Full code is at:
http://pastebin.com/yVeZuAY2
With a demonstration of the
system at:
https://www.youtube.com/watch?v
=efA9lwmE5zA

// buzzer is on pin A2

int notes[]={
// possible notes to play
};

NOTE_A4, NOTE_B4, NOTE_C3

and:
pinMode (buzzer, OUTPUT);
//the buzzer
analogWrite(armedLed, 0);
//start as off
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I also added to the ‘wrong
guess’ code:
tone(buzzer,notes[1],200);
//boop! wrong code.

which just plays tone 1 , a ‘boop’
noise, to let you know you got the
code wrong.
You could, of course, use a
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Ronnie is the founder and (still!)

editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.
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W ri t e F o r F u l l C i rc l e M a g a z i n e

Written by Ronnie Tucker

G UIDELINES

T

he single rule for an article is
that it must somehow be

document.

REVIEWS

• Images should be JPG, no wider
than 800 pixels, and use low
compression.

G AMES/APPLICATIONS

linked to Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc). • Do not use tables or any type of
bold or italic formatting.

RULES

• There is no word limit for articles,
but be advised that long articles
may be split across several issues.
• For advice, please refer to the

Official Full Circle Style Guide :

http://url.fullcirclemagazine.org/75
d471
• Write your article in whichever
software you choose, I would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND

GRAMMAR CHECK IT!

• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

If you are writing a review,
please follow these guidelines :
When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

TRANSLATIONS
If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you access
to the raw text to translate from.
With a completed PDF, you will be
able to upload your file to the main
Full Circle site.
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When reviewing games/applications please state clearly:
•
•
•
•
•
•
•

title of the game
who makes the game
is it free, or a paid download?
where to get it from (give download/homepage URL)
is it Linux native, or did you use Wine?
your marks out of five
a summary with positive and negative points

H ARDWARE

When reviewing hardware please state clearly:
•
•
•
•
•
•
•

make and model of the hardware
what category would you put this hardware into?
any glitches that you may have had while using the hardware?
easy to get the hardware working in Linux?
did you have to use Windows drivers?
marks out of five
a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
24
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Get 25% off any SpiderOak package
with the code: FullcirclemagFans
contents ^

I

L I N U X L AB

C o m p i l i n g A Ke rn e l - P a rt 4

Written by Alan Ward

tad complicated to open up, and
Linux Mint 1 7 runs quite well off
even worse to put back together
the SD Card.
again with all the screws in the
correct holes! – we can obtain quite
a lot of information on the
Internet. Some reviews of the time
are still available, such as
Notebook Review's of the 4GByte
model “Asus Eee PC 4G Review”
(http://www.notebookreview.com/
notebookreview/asus-eee-pc-4greview/ ), or Marc Spoonauer's
“Asus Eee PC 701 Review” for
GETTING
TO
KNOW
Laptop Guide
In this fourth installment of the
THE
TARGET
(http://www.laptopmag.com/revie
series, we will be looking into how
w/laptops/asus-eee-pc-701 .aspx ).
COMPUTER
to make some changes and apply
The Ubuntu users' world is also
simple tweaks to our kernel, and
The 701 model target computer well cared for by help articles on
how they affect system
is one of the first series. As such, it the community wiki
performance. To take a simple
(https://help.ubuntu.com/communi
came with a very basic
example as our guideline, we will
ty/EeePC ).
configuration that could handle
be working on a kernel for the
The specifications of the
Microsoft's Windows XP, or a
original Asus eeePC model 701
Finally, if you have problems
original model are as follows: Intel
bespoke variant of the Xandros
from back in 2007. Seven years
getting
a
recent
version
of
Ubuntu
Celeron M 900 MHz processor, 51 2
already – but we can put some new GNU/Linux distribution. Before
on it and running, my piece called
MBytes of RAM, 2 or 4 GByte SSD
life into this very early predecessor breaking out the compiler and
“Install 1 2.1 0 onto an EEE PC” in
hard disk, 800x480 resolution 7
actually doing things at the
of the netbook fad.
FCM#68
inch screen, and no optical drive.
keyboard, let's take some time to
(http://fullcirclemagazine.org/issue
Naturally enough, we will not be see what exactly the eeePC has
-68/) is still fairly current, and
Some points need to be made,
doing the compiling on the eeePC under the hood.
should get you going even with a
however. The CPU is actually an
itself – since it would take quite a
under-clocked (at 667 MHz)
Even without cracking it open – more recent version of your
long time to complete. Besides
favorite
distribution.
For
example,
derivative of the Pentium-III.
which is not recommended – it is a
which, due to hard drive size
n the last part of our series on
compiling the Linux kernel for
Ubuntu, we - finally! - managed to
configure a new kernel. We
compiled the kernel itself, as well
as the accompanying modules.
Finally, we installed all this in the
appropriate directories - /lib and
/boot - built a new initrd
compressed file system, and
modified the GRUB configuration
to allow us to boot the new kernel.

constraints, we would have to
import the source and do the
compiling on an external drive
connected through USB, also
incurring a severe speed drop.
Instead of this, we will be
compiling the kernel on another,
more capable, computer, and then
transferring the kernel and
modules over to the eeePC when
finished.
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/proc/cpuinfo reports 630 MHz, no
doubt to reduce overheating and
extend battery life. /proc/cpuinfo
also reports the presence of the
PAE extension in the processor on
my model, though other users (e.g.
our esteemed editor, Ronnie) have
reported otherwise. Perhaps
slightly different batches of the
Mobile Celeron-III were sourced
during production.

replacement that doubles the
original capacity, which, with
modern versions of GNU/Linux's
needs, is no luxury. However, if you
do go down this path, please do try
to use a class-1 0 device; inferior
cards have slow write rates and will
cause your system to slow down
noticeably.

Boot-up times with Xubuntu
1 4.04, or the Linux Mint 1 7 Mate
desktop edition, may be called
RAM is of the DDR-2 type,
clocked at 666MHz. There is space “leisurely” at best. Once running, a
glance at Mate's system monitor
for two RAM slots under the
motherboards, though only one of gives us some more information
and shows us where some
them actually has a slot soldered
in. The 51 2 MByte original RAM can tweaking can take place.
easily be replaced with a 1 GByte
PC2-5300 part of the same type,
should you have one available.
The hard drive is an SSD model.
However, the bus connection with
the motherboard is actually a PCI
Express module, also soldered in.
This means the original hard drive
has little chance of getting
replaced with something more
current. However, the USB 2.0
ports work well with external
drives, and the BIOS is quite happy
booting either off a USB drive, or
off the integrated SD Card reader.
An 8 GByte SD memory card makes
a fairly cost-effective hard disk
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It is clear memory is not much of
an issue, with just 252 MBytes in
use when the full Mate desktop is
running. Since we shall probably
not be doing any heavy lifting with
this processor and drive (video
editing, someone?), the original
51 2 MByte memory should suffice.
1 GByte, as in this model, is
probably overkill.

probably be here with the CPU.
Seeing CPU use go up to 1 00%
during what was effectively some
very light web browsing confirms
this idea.

On the other hand, the
processor has the rare
characteristic of exhibiting just one
core. No dual- or quad-core
processor in this one, then. No
hyper-threading with virtual cores
either. So, if we run into a
performance bottleneck, it will

We are compiling a kernel for a
specific hardware platform, so we
are no longer under the constraints
that a distribution has to contend
with, i.e. handling a maximum
number of different hardware
setups. This is why our approach
can be a tad more radical. On the
one hand, we will gut the kernel
completely, stripping out whatever
we know will not be needed on the
target system. On the other, we
will make sure we put in any
features that can help get the most
out of the slightly punny chips
inside.
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CONFIGURING A
SPECIAL-PURPOSE
KERNEL

Before starting, let us remind
ourselves to compile this 32-bit
kernel from within a 32-bit
operating system, as noted in the
previous part of this series.
Although cross-compiling the
kernel from a 64-bit platform
should work, it actually does not on
contents ^
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the Ubuntu 1 4.04 64-bit version
with the 3.1 3.1 1 .2 version kernel
source – the resulting kernel will
compile, but will fail to execute on
the target machine. This being said,
there would be no problem with
installing a 32-bit version of
Ubuntu on the compile machine
(e.g. in a separate partition from
the main operating system), even
though it contains a more modern
64-bit processor.
We want to make sure we don't
have any little bits of configuration
cruft lying around from previous
projects, so we issue:

In sub-menu “General setup”,
we will not need the “Cross
compiler”, “Compile also drivers
which will not load”, or “Local
version”. As for “Kernel
compression mode”, this refers to
the vmlinuz file compression. It
defaults to “Gzip” instead of the
more common “Bzip”, which is fine
for us since Bzip compressed data a
bit more, and so saves some disk
space. But it also needs
substantially more processing to
decompress – and CPU power is
what we are lacking on the target.
So “Gzip” it is.

We will also configure the
“Arbitrary version signature”,
putting something significant in its
Now, let's get into any of the
place. Most of the other options in
configuration scripts. I will be using this sub-menu may be left as they
a “make menuconfig”, but, as seen are: if at all unsure about a feature,
in the previous part of this series,
leave it in since parts of the
any other configuration script will operating system may need it.
offer us the same options.
I will be deactivating “Support
We will start at the top of the
for paging of anonymous memory”
main menu, and go progressively
a.k.a “swap”, since I have 1 GByte
down the list. To start out, we need of RAM – and don't like to use swap
to uncheck the “64-bit kernel”
anyways. Owners of 51 2 MByte
option, since the Pentium-III and
models would probably do better
this particular Celeron are 32-bit
to leave swap activated.
only. This will unlock more 32-bit
options further down.
Lower down, we can configure
the initrd file, which we will set up
full circle magazine #91
$ make mrproper

to use only gzip, for the same
reason we left vmlinuz as a gzip
file.
Going back up to the main
menu, leave “Enable loadable
module support” activated.
Although it is theoretically possible
to have the complete kernel and all
the modules necessary built-in
inside a single vmlinuz file, this
would also mean all drivers would
be loaded into memory on boot.
This is surely a waste of memory,
unless we know very precisely
which modules we will need.
We can also leave “Enable the
block layer” on, since it is needed
to access block devices, such as
hard drives.
Now, on to “Processor type and
features”. This is where we can do
some specific tuning. Contrary to
popular wisdom, we will turn off
“Symmetric multi-processing
support”. This is because we are in
a very rare case nowadays, in
targeting a processor with no
multi-core or virtual cores. So out it
goes. We will also turn off “Support
for extended (non-PC) x86
platforms”, since the eeePC has a
rather typical PC architecture. We
will not need the “Intel Low Power
Subsystem Support” since we do
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not have the hardware, nor “Linux
guest support” since this kernel is
targeted at a physical computer
and not a virtual machine.
“Memtest” can also go.
We are arriving at the
“Processor family” option. Select
“PentiumIII/Celeron(Coppermine)”. This way,
we get support for the full range of
the Pentium-III instruction set,
which we would not by using the
default kernel from the
distribution. Distribution packagers
tend to leave this option at
“Pentium-MMX”, which is fine since
it will work on anything from a
Pentium-I 1 66 or 200 MHz
onwards. On a Pentium-III,
however, some features that are
available in the hardware would
not be accessible. If it's there and
available to us, let's use it: we need
all the power available.
Let us leave “Generic x86
support” off, since we are being
very specific about the computer
we are targeting. Moving on, we
can deactivate options such as
“Toshiba Laptop support”, “Dell
laptop support”, and “CPU
microcode loading support” unless you intend to upgrade your
CPU microcode. Most people will
contents ^
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not need this.

863 MBytes seen in the following
screen capture: an eeePC running
The “High Memory Support”
the modified kernel we are now
sub-menu requires some attention. building. Please see the page at the
We will obviously not need the 64 following address for further
GByte RAM option, that
details:
complicates things by introducing
http://unix.stackexchange.com/qu
the option to compile PAE into the estions/4929/what-are-highkernel. With a maximum of 1 GByte memory-and-low-memory-on-linux.
RAM in our target machine, we can
safely leave both the 64 GByte and
Naturally, PAE likewise can stay
4 GByte options, and simply leave
off.
High Memory “off”. However, we
should be aware that most low-end
Of the remaining options in this
computer systems share part of
sub-menu, most can safely be left
their RAM between the
at their default settings. Just make
motherboard and the graphic card. sure “MTRR support” is on - this
This means that a computer with 1 feature is part of the Pentium-III
GByte RAM will report, within the
instruction set and can accelerate
operating system, the presence of execution - and “EFI runtime
about 993 MBytes of useful space – service support” is off, since this
as seen in the eeePC screen
feature has been introduced only
capture above. When switching off in computers such as Apple's
“High Memory Support” in the
Macintosh, and, more recently, in
kernel, during execution the kernel machines destined for Windows 8.
will reserve the upper 1 28 MBytes
of RAM for its own use – and so
Back in the main menu, we go
user memory space will find itself
down into sub-menu “Power
quite remarkably reduced to the
management and ACPI options”. In
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here, the “Suspend to RAM and
standby” option may be
deactivated unless we want to
sleep our computer. “Power
Management Debug” only gives us
information in the event of a crash,
so off it goes. “CPU Frequency
scaling” will also be deactivated
because I find our little eeePC is
already under-throttled sufficiently
for my taste.
Back in the main menu, in submenu “Bus options”, the “PCCard”
and “RapidIO” options can be
switched off.
Moving on in the main menu, in
“Networking support” a load of
features can be turned off, such as
“Amateur Radio”, “CAN bus”,
“IrDA”, “Bluetooth”, “WiMAX”,
“Plan 9”, “CAIF” and “NFC
subsystem” - unless, naturally, you
wish to use these types of
hardware (through a USB dongle?)
or software.
In the “Device drivers” section
of the main menu likewise, options
such as “Parallel port support” can
be deactivated. However, I tend to
leave much of this stuff in, unless I
am reasonably sure I will never
need it, as most device drivers are
in fact modules that will not be
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loaded. Module mode “M” is the
key here.
In the “File systems” section,
much of the same is applicable.
Most users will be able to remove
support for the “Reiserfs”, “JFS”,
“XFS”, “GFS2”, “OCFS2”, “btrfs”,
and “NILFS2” file systems, as well
as the “CD-ROM/DVD Filesystems”.
In the “DOS/FAT/NT Filesystems”,
“VFAT” may sometimes come in
useful if you are planning on using
an external USB thumb-drive in this
format.
“Kernel hacking” is perhaps best
left alone: most of the stuff in here
is mostly useful to debug a kernel
during development. In “Security
options”, I personally do not use
SELinux, and deactivate the “NSA
SELinux” option. Likewise for
“Tomoyo Linux Support”,
“AppArmor”, “Yama” and “Integrity
Measurement Architecture”. These
are tools destined for specific
situations that the average
desktop user will probably not find
himself in.
Back in the main menu, nothing
needs to be configured in the
“Cryptographic API”. As for drivers,
it is best if in doubt to leave stuff in
that the kernel or other libraries
contents ^
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may need, if only to verify apt
package signatures. In
“Virtualization”, however, we can
deactivate everything since our
system will be neither host nor
client for kernel-level
virtualization. I would also leave
“Library routines” at their default
values.

COMPILING, TESTING
AND INSTALLING
Once we have all the kernel
options set up, we save the
configuration with the default file
name “.config”, and proceed to
compile it:

$ sudo bash
# make modules_install
# make install

If all goes well, reboot the
computer, and test the new kernel.
If the machine you are compiling
on has a newer processor than the
Celeron, all should go well. If you
got a kernel error at boot up, e.g. a
kernel panic because something
was missing, read carefully the
error message. If at a loss, Google
can give some insight on what has
happened – you will surely not be
the first one to encounter such a
problem. Then reboot the
computer and, in the GRUB menu,
select “Advanced options for
Ubuntu” (or similar), and reboot
using the previous kernel.

reason. Possible causes can include
a hard drive with a GUID partition
table, simply running low on RAM,
since 51 2 MBytes is considered
extremely low for a modern
system.

me good results. Initial
compilation:

Another possibility is having a
bloated initrd file. This latter does
happen with the Ubuntu system
and kernel source, and is easy to
detect by executing

$ sudo bash

ls -lh /boot

The resulting kernel vmlinuz file
should be about 1 0-1 5% smaller
than the original. The initrd
compressed file system should
weigh 1 6 MBytes or less,
depending on the modules that
have been deactivated.

You should see the original
initrd.img file weighing in at about
1 9 MBytes (specifically version
3.1 3.0-24-generic). If the initrd.img
file you have generated goes way
$ make
up into the 1 00 MByte mark, you
have run into initrd bloating. This is
Some time later - though a tad
due to the fact that, during
less than when compiling the
compilation, a host of debugging
kernel with the default
In some cases, the kernel will
symbols have been retained within
configuration - the system reports start up well, and then crash on the the kernel and library executable
that all has gone well. Now, we will following error:
code. The interested reader can
begin by installing our new kernel
see more about this at the
Starting init: /bin/sh exists
on the same computer we
following address:
but couldn't execute it
compiled it on. This is because if
http://unix.stackexchange.com/qu
(error -8)
something were to go wrong, it is
estions/30345/why-is-my-initialeasier to test it out and recompile
ramdisk-so-big. The solution
This is usually due to the
if necessary before transferring the computer running out of memory
proposed in this reference is to
kernel to the eeePC. So we go into when the kernel itself has been
explicitly tell the compiler to strip
administrator mode, and perform
loaded, but the initrd compressed out debugging symbols. The
installation:
following commands have given
file cannot be loaded for some
full circle magazine #91
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$ make INSTALL_MOD_STRIP=1

and kernel installation:
# make INSTALL_MOD_STRIP=1
modules_install
# make INSTALL_MOD_STRIP=1
install

When running the new kernel
on the computer used to compile
it, it may be interesting to run
system monitor. In the next screen
capture, a Core i5 is running the
new kernel. We may note that RAM
is given as 863 MBytes, when the
machine actually holds a full 4
GByte complement. This is because
we turned High Memory off during
compilation. In the same way, since
we turned multiprocessing off, the
next monitor tab reports the
presence of a single CPU kernel,
contents ^
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and not the four reported by
regular kernels. As a side note, we
can see the new kernel compiled
from the Ubuntu 1 4.04 distribution
mixes well with a previously
installed Linux Mint 1 7.
Finally, we need to install the
new kernel on the eeePC. In my
case, I simplified things by not
using the eeePC's internal drive.
Instead, I am using an 8 GByte SD
Card as the main hard drive, so it
was merely a question of inserting
this drive into the computer I
compiled the kernel on, and
copying the files over. With the SD
card inserted and in administrator
mode, supposing the new kernel
has version number 3.1 3.1 1 .2:
$ sudo bash
# cp
/boot/*3.13.11.2
/media/<your-username>/<volume-name>/boot/
# cp -r
/lib/modules/3.13.11.2
/media/<your-username>/<volumename>/lib/modules/

Now, remove the SD card from
the compiler machine - remember
to unmount first! - insert it into the
eeePC and boot. The GRUB
configuration on the SD card has
not yet been updated, so it will still
be booting into the original kernel.
Now, open a terminal, and as
administrator renew the GRUB
configuration:
$ sudo bash
# grub-update

That's it, from now the GRUB
menu's default boot option should
be the new kernel and initrd. As
discussed previously, the second
option should still grant you access
to the original kernel installed by
the distribution, so with a bit of
luck you should not end up locked
out of your own computer (one
hopes)!
When testing out the new
kernel, for example browsing some
slightly complex web pages with

Javascript and active images
running, the processor should not
get pegged at 1 00% capacity quite
as often. A slight, but noticeable
gain in speed should be apparent in
general system operation. As a
supplementary benefit, the
processor is now using the more
complete instruction set for the
Pentium-III. The supplementary
instructions contain some
parallelism built in, so the CPU
needs to execute less instructions
to complete any given task,
resulting in less heat generation
and perhaps even a tad more
battery life. However, YMMV (Your
Mileage May Vary), and you will
need to check this out for your own
specific work-flow.
Once the new kernel is installed
and working from the SD-Card or,
perhaps, an external USB drive, to
install it on the eeePC's internal 4
GByte hard drive is also just a
matter of copying over the files in
boot (vmlinuz, initrd, System.map),
and the complete library directory

in /lib/modules, and then updating
GRUB on the target system once
booted.
In this part we went through a
specific case of kernel compilation,
designed to actually implement the
configuration, compilation and
installation discussed in part three
of this series. The eeePC is a small,
lightweight notebook that still
holds its fascination for some of us,
besides being actually useful from
time to time. It's external shell is
really tough, compared to some
more modern offerings, which can
always help if we should need to
use a mobile computer on the go.
In the next episode, we will see
how to start hacking the kernel
code itself, making small changes
in the source code and seeing what
comes out of it.

Alan teaches computer science at

Escola Andorrana de Batxillerat
(high-school). He has previously
given GNU/Linux courses at the
University of Andorra and GNU/Linux
systems administration at the Open
University of Catalunya (UOC).

The first copy operation copies
over the kernel image and initrd
file, the second copies the
complete module library from /lib
to the new system.
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Kod i /XBM C Pt. 2 - Softwa re

Written by Charles McColm

slideshow of all your old family
photographs and have music
playing in the background – the
trick is to start playing the music
first, then hit the pictures button
on your remote, find your
photographs, and press the play
button on the remote to start your
slideshow. Much of XBMC’s
flexibility comes from the plethora
of add-ons available for it – that
range from lyric downloading addons to add-ons that show Internet
streaming video (Twitch.tv and
Youtube for example). If you know
how to set up a PVR back-end like
Myth TV, NextPVR or TVhead, you
can even use XBMC as a front-end
to record and watch your favourite
television shows (a tv tuner card is
XBMC can play most music file
formats: flac, mp3, wav, wma, and a required for this functionality).
host of video file formats. XBMC
For our home entertainment
can also stream. Take the scenario
system, we’ve used XBMC on an
where someone wants to watch
atom-based netbook, an Androidtelevision (where your XBMC
based PIVOS XIOS DS Media play
system is hooked up to) and you
box, and a full-fledged Linux PC.
want to watch a movie stored on
the system, you can just grab your The last option has served our
family best because of the
tablet or phone and have XBMC
stream to the tablet. Having family flexibility. Both the XIOS DS and
the netbook were nice because of
over you haven’t seen in awhile?
the size, but we needed to attach
With XBMC you can create a
odi/XBMC entertainment
center is a pretty incredible
piece of software. Not only is it
available for Linux, but also
Windows, OS X, Android, iOS (on
Apple TV), and for hardware like
the Raspberry Pi and Android
phones and tablets. Release 1 3.2 is
the last release to use the name
XBMC; future releases will all be
known as Kodi, in part because
XBMC has never worked on newer
XBox machines, and because Kodi
has evolved to more than just a
media center. For this article, we’ll
refer to the old name, XBMC, since
Kodi doesn’t have an official
release yet.
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our drives via USB and that
required more power outlets. We
could have built a separate NAS
box elsewhere, but again it’s a
whole other box, it was simpler just
to build XBMC in one box with
multiple drives.
Our netbook was fine for
standard definition video, but it
struggled with high definition
video. For HD you’ll want a dualcore system. Our system has an
Intel Core 2 Quad Q8300 processor
that handles all video beautifully at
1 920x1 080. On the software side,
we used xbmc.org’s Linux
distribution + XBMC, better known
as XBMCbuntu to install.
Installing XBMCbuntu is fairly
straightforward. If you’ve installed
any form of Ubuntu, the
installation process is exactly the
same. Installation can be a bit
tricky if your machine is connected
to your television and you’re using
a DVI or HDMI cable. XBMCbuntu
sometimes fails to detect the
proper EDID (Extended Display
Identification Data) which causes
distortions (in our case tiny text
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and a stretched interface). If you
know all the steps in the Ubuntu
install, you can actually type
through the EDID problems, and
XBMC will eventually load nicely,
but if you ever fall back to the
window manager it will appear
distorted.
We use an NVidia GeForce 21 0
card that has VGA (DSUB), DVI and
HDMI, so installing with a readable
interface was simply a matter of
connecting the VGA cable to our
TV (which also has VGA). If you
want to use the fallback window
manager, have a look at the
Ubuntu manpages for get-edid,
and read-edid:
http://manpages.ubuntu.com/man
pages/lucid/man1 /get-edid.1 .html.
Oddly enough, stock Xubuntu
seems to detect our television just
fine over HDMI, the problem seems
to be restricted to using
XBMCbuntu. If you choose to start
with stock Ubuntu/Xbuntu/variant,
you’ll need to do more work
configuring your remote using
LIRC, installing video drivers, and
setting up SSH to name a few
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details XBMCbuntu takes care of.
Perhaps the simplest way to
cover major features of XBMC is to
step through the main menus in
the default theme (Confluence)
menu. The menu options in
Confluence are Weather, Pictures,
Videos, Music, Programs and
System. Movies and TV Shows
menu options appear once you’ve
added a movie or TV show
directory through the Videos
menu. Different themes (available
through the System > Settings
menu) will display different menu
options. Some themes add other
functions. Most of the menu
choices also have sub-choices.
Videos has a sub-menu of Files,
Library and Add-ons, for example.
XBMC provides a first run help
when you first click in these menu
options.
The Weather menu doesn’t
display weather until configured
through an add-on. The simplest
way to set-up weather is to click
System > Add-ons > Get-Add ons >
XBMC.org Add-ons > Weather, and
choose from the Met Office (UK),
Oz Weather (Austrailia), Weather
China, Weather Underground,
World Weather Online, or Yahoo!
Weather. Weather Underground

recently got marked as broken in
the repository, and World Weather
Online is incompatible with XBMC
1 3.x. For Canada/US, Yahoo!
Weather currently works well.
Once you install the add-on, you’ll
need to configure it. Click on the
name of the add-on you chose
(Yahoo! Weather in our example)
then click Configure. You can set
up to 3 Locations. To set up a
location, click on one of the three:
Location 1 , Location 2 or Location 3
choices, and enter your location or
a major city near you. Weather now
should display if you click on the
Weather menu option.
By default, XBMC displays the
current temperature, whether it’s
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sunny, cloudy, rainy, etc., what the
temperature actually feels like (it
might be 7 degrees Celsius and feel
like 2 degrees), the humidity, uv
index, and where and how fast the
wind is coming from. The Yahoo!
Weather add-on also displays a
week of weather on the right side
of the current temperature. To
change to another location, click
the left arrow button on your
remote control (or the left arrow
on the left side of the screen). The
View options for the weather
menu appear on the left side. From
the options, you can cycle between
the cities you chose to set up,
refresh the weather, change the
settings (location on the Yahoo!
Weather add-on, weather maps on
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other plug-ins), hide the fan art
displayed beside the temperature
or set the path for the fan art.
Earlier, I mentioned the
temperature in Celsius, but the
default XBMC setup was originally
in Fahrenheit. To change to Celsius,
we needed to click Settings >
Appearance > International, and
change the Region option which
(was set to US) to Canada (or
whatever country you live in).
Clicking on the Pictures menu
brings up Picture Add-ons,
Pictures, and Add-Pictures options.
We copy pictures using SSH but
XBMCbuntu is set up to be a
SAMBA machine so Windows
machines on your network can drag
and drop files to a folder that you
can add as a picture source. We
organize our photographs into
directories by event. Like the
weather menu, you can change
various picture options by clicking
on the left arrow on your remote
or on the left side of the Pictures
display. Options include View, a
couple of sorting options, filters,
slideshow options and randomize.
You’ll see the view option on
several of the menus (movies,
television shows and music).
Changing the view allows you to
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change how the pictures or
directories are shown on the
screen. By default, Confluence
displays pictures in a list-view
which shows files and directories
on the left side and a few
thumbnails on the right side.
Switching to big list only displays
the file/directory names.
Thumbnail view displays a box of 4
thumbnails for each directory or
simply thumbnails for the pictures.
The Pic Thumbs view splits the
screen again and displays a
thumbnail on one side and a larger
version of the picture on the other.
Image wrap displays the
thumbnails across the bottom and
a larger picture in the middle of the
screen. Many of these view options
also appear in the movie, tv show,
and music menus. To display a
slideshow of pictures, use the
arrow buttons to navigate over a
picture and hit the play button on
your remote. If you’re using a
mouse, use the slideshow option in
the view menu.
From the videos menu, you can
add movies and tv shows. Adding
movies or tv shows is almost the
same process. Click Videos > Files >
Add Videos. You will be prompted
to Add video source. If you know
the path where your movies or

television shows are, you can enter
it into the field that says <None> or
click the Browse button to browse
through your directories until you
find the directory with your media
content. Once you’ve finished
adding the path to your media, give
it a name, for example: Anime or
Old Movies. Next, you set the type
of content; the choices are: None,
Music videos, TV Shows, and
Movies. For Anime, use the TV
Shows scraper. Click OK when
done.
A scraper is a program that
“scrapes” a website for
information. In the example above,
XBMC scrapes The TVDB website
for information about our Anime
shows (to scrape Anime set the
media as TV Shows). XBMC will
then ask if you want to refresh the
info for all the items. Depending on
how many items you have, this
could take anywhere from a few
seconds to several minutes. XBMC
has a choice of scrapers for each
type of media.
We use the Video add-ons
almost as much as we do the
movies and tv shows menus. Lots
of great add-ons exist to watch
content like TED Talks, Revision 3,
Twitch.tv, sports, NASA content,
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music videos, trailers of upcoming
movies, or the infinitely exciting
VIMcasts (learn VIM). I mock
VIMCasts, but there are some very
cool shows like VIMCasts to teach
coding. Before you can watch an
add-on, you have to get it. To get
add-ons, first go through the
System > Add-ons menu and click
Get Add-ons. XBMC comes with a
handful of add-ons, but you can
add more add-on repositories, just
as you would a Linux distribution
(for more software). There are lots
of youtube videos covering adding
other repositories to XBMC so we’ll
skip that here.
Clicking on the movies menu
brings up the list-view of movies (if
you have any installed). In list-view,
pressing the right arrow on your
remote will bring up the view
menu. If you change the view to
the Poster Wrap view – which
scrolls DVD cover art right and left
– you need to press the up arrow
on the remote to bring the view
options menu up. Default views in
movies are: List, Big List,
Thumbnail, Poster Wrap, Fan Art,
Media Info, Media Info 2, and
Media Info 3. The Fan Art and
Media Info views display the most
information about movies, while
Thumbnails and Poster Wrap
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display only images. If you have a
remote control with the Guide
button, you can press Guide while
on top of a movie to bring up
movie options: Queue item, Play
from here, Add to favourites,
Movie information, Mark as
watched, or Manage. We use the
Queue item from time to time to
play movies and their sequels.
The TV Shows menu is similar to
the Movies menu, but includes a
Wide view that displays art in a
banner ad format. Like the movies
options, you can sort a number of
ways, filter content, hide watched
shows, search for a show, update
the library of shows, or show the
current playlist.
Movies, music videos, and
television shows all need to be
named a certain way for the
content scrapers to correctly figure
out the show. For example, it’s
important to discern whether
you’re watching the first show of
the first season of Dr. Who, or the
ninth season. The Kodi/XBMC wiki
is the best reference for naming
videos:
http://kodi.wiki/view/Naming_vide
o_files
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Music is different from video
because you must have proper id3
tags for XBMC to correctly parse
the music. Easytag is a popular
GTK+ id3 tag editor. On the KDE
side there’s kid3.
Easytag:
https://wiki.gnome.org/Apps/Easy
TAG
Kid3: http://kid3.sourceforge.net/
The Music menu also has a lot
more options: Genres, Artists,
Albums, Singles, Songs, Years, Top
1 00, Recently added albums,
Recently played albums,
Compilations, Playlists, Search, and
Music Add-ons.
When you’re looking at the
music library, you can bring up the
view options by clicking on the
arrow on the left side of the screen
or using the left arrow on the
remote control. The music view has
a couple of options not present in
other media types: Library mode or
Party mode. Library mode is as it
sounds, a listing of your music
library. Selecting Party mode starts
playing a random selection of your
collection with both album and
background art. We also have the
CU LRC Lyrics plug-in installed so
lyrics are also displayed.

To add a music add-on, navigate
to the music menu option; files and
add-ons appear below the menu.
Either click on the music menu and
then click Music Add-ons, or just
click the add-ons sub-menu option
that appears below the music
menu option. Click Get Add-ons to
pick from the stock add-ons. Some
of the default add-ons that caught
our eye were the Apple iTunes
Podcasts (you don’t need an iTunes
account to play them),
Grooveshark XBMC, High Voltage
SID collection (currently broken,
but cool if you like playing tunes
from the Commodore 64 era),
Internet Archive, JamBMC

(Jamendo radio), NPR (National
Public Radio), Pandora radio,
Shoutcast 2, Soundcloud and TWiT.
There are more add-ons, and you
can add even more by adding other
XBMC add-on repositories through
the System menu.
The Programs menu is empty
until you add some add-ons. In our
house, we use the Artwork
Downloader add-on which
downloads extra artwork for
television shows and movies,
Movie Quiz – a fun quiz that goes
through your movie collection and
asks questions based on your
collection, TV Tunes – which
fetches the theme songs for your

television content and plays the
theme when you browse the show
seasons or files, and XBMC Library
Auto Update – which automatically
updates your music/tv show/music
video/movie libraries.
There are lots of other
interesting add-ons in the stock
add-ons including add-ons to
display Facebook media, an XBMC
forum browser to show the XBMC
forums in XBMC, a GMail checker,
ircChat, Linphone support, a ROM
collection browser for those who
love retro gaming, a plugin for
Sonos owners, a plug-in for
bittorrenting using Transmission,
and a PBX plugin for Asterisk.
The System menu is where a lot
of other XBMC magic occurs, from
enabling repositories, getting addons, setting up locales, to SAMBA
setup, enabling other forms of
remote control, getting and
enabling new skins, to multi-profile
setup.
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The System sub-menu – the
menu below the System menu text
on the main XBMC screen – differs
from the menu you get when you
click on System. Clicking on System
brings up System > Settings which
is actually one of the sub-menu
contents ^
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options. The File manager submenu settings are used for
browsing the file system and
adding repository shortcuts.
Profiles allows you to set up XBMC
so different users have different
set-ups. Typically, people use this
to restrict access to adult content,
but it can also be useful if you want
to present someone with a simpler
interface (theme) and set of addons that’s more consistent with
their likes. The System info submenu brings up another menu of
useful information divided by
hardware type, including a
summary, storage information,
network information, video
information, hardware information
(CPUs and RAM), and, if you have
PVR (Personal Video Recorder think MythTV) functionality set-up,
information about the PVR service.
From time to time, we refer to the
network information if we’re
having an issue with our network.
Storage is also handy for when you
think you’re approaching the end
of a drive.

settings options and some of the
ones we use. The main System
settings are Appearance, Video,
Live TV, Music, Pictures, Weather,
Add-ons, Services, and System.
Clicking on Appearance brings up a
new menu full of options that
allow you to control anything from
font size zooming to whether
hidden files and directories are
shown. We already touched on the
International menu in order to
change from Fahrenheit to Celsius.
The Skin menu is the menu most
people are interested in checking
out. Clicking Skin, then rightnavigating and clicking on Skin >
Confluence > Get More lets you get
more XBMC themes. Skins can
dramatically change the look and
some of the functionality of XBMC,
this includes the main menu that’s
displayed on startup. When we
change to Ace, for example, the
main menu options become
Movies, TV Shows, Concerts, Music,
Favourites, Games, Images,
Weather, Settings, and Exit. While
some of the menus are simply
other names for the same thing,
The System menu actually
other options like Favourites would
brings up the majority of the
have been buried in a sub-menu
settings for XBMC, and there are a under Confluence. Themes can also
lot of settings that go multiple
change how content is displayed
levels deep. XBMC is huge, so, to
(the view). Some themes add more
keep it brief, we’ll just touch on the information to the view than
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others. Pay attention when
changing themes, it can be tricky to
navigate your way back to change
the theme to something else.
Under the Ace theme, the System
menu is sensibly called Settings. If
changing the theme wasn’t enough
for you, you can control each
theme’s settings from System >
Appearance, and, on the Skin tab,
navigating to the Settings option
under the Skin name. The Skin
settings brings up yet another submenu of options to control the
skin, We use the Add-on Shortcuts
tab to show our favourite add-ons
on the home screen below the
menu names.
System > Video brings up
another entire sub-menu of
options. Worth looking at are the
Acceleration tab to ensure you’re
using your video card’s
acceleration features, and the
Subtitles tab which lets you set
things like the location of sub-titles
(both on the screen and the path
subtitles are stored when they’re
downloaded) as well as the size,
style and font.

within XBMC. We don’t use this
functionality in XBMC, but it exists
and is worth mentioning for those
who do.
System > Music displays a submenu for controlling your music
media collection. If you don’t like
how XBMC wants music named,
you can change how tracks should
be named. You can change the
default action when audio CDs are
inserted into your XBMC system
(the default action is to rip an
audio CD, encode it with lame, and
eject the CD when done. You can
also change which visualization
(OpenGL Spectrum) is displayed by
default when you start playing
music. There are a lot of options to
explore right down to crossfading
and karaoke support.
System > Pictures displays a
mercifully small set of menu
options, but even this sub-menu
has about 7 different options –
that range from panning and
zooming during slideshow playback
to whether video files are shown in
picture listings or not.

System > Live TV has a bunch of
The System > Weather menu is
options for controlling PVR
even sparser showing only a couple
functionality. Look here if you want of settings, the weather service to
to control your TV Tuner card from use and the settings for that
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weather service. It’s sparse perhaps
only because some of the options
that would be helpful here (the
International menu for choosing
country and getting Celsius /
Fahrenheit) are elsewhere in
XBMC.
We touched on the System >
Add-ons menu. System > Add-ons
extends XBMC by allowing you to
get Add-ons from different
repositories to extend the
functionality of XBMC. There are a
lot of Youtube videos about how to
add various add-ons but a warning
is perhaps necessary here; be sure
to back up your XBMC settings.
Using repositories and add-ons
other than those sanctioned by
XBMC can really mess up XBMC to
the point where it’s simpler just to
rm -rf ~/.xbmc/ and start from
scratch.

problems displaying EDID and used
a VGA cable to set up XBMC, and
then switched to HDMI, you can
often switch the resolution by
selecting System > Settings > Video
Output > Resolution. If audio isn’t
working right, check the Audio
output tab on this menu. From
time to time, we’ve used the
Internet access tab to set a proxy
just for XBMC.
We’ve covered all the main

menu options for XBMC, and yet
we’ve really only barely scratched
the surface of what XBMC is
capable of. XBMC is one of those
programs that the more you dig,
the more options you find, and
friends are doing some pretty
amazing things with some of the
XBMC plug-ins and other software:
Flexget and the Transmission web
front-end plug-in for example.
XBMC is one of those programs

that’s YMMV, Your Mileage May
Vary, depending on the effort you
put in to customizing it the way
you like it. We find it’s pretty
amazing.

U SEFUL LINKS:

Kodi/XBMC keyboard controls:
http://kodi.wiki/view/Keyboard_co
ntrols
Kodi/XBMC - http://xbmc.org - will
likely change in the future

System > Services contains the
options for controlling XBMC via
UPnP (Universal Plug and Play), via
http (used by software remotes
like those on some Android
applications) as well as Apple
AirPlay and SAMBA options.
Finally the System > Settings
menu is useful for adjusting sound
and video options. If you had
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E l e m e n t a ry 0 . 4 B e t a 1

Written by Michael Davies

I

the only bug I found is that the
date disappeared from the top
panel and there is no way to reinstall it; remember it is a beta
release. The dock at the bottom
shows some static items and
any open windows. You can
right click any icon and elect to
pin it to the dock permanently,
or remove it. My only gripe with
this is that you cannot
I liked the fact that the
download was small compared recognize whether the icon
with many ISO's, less than 1GB. represents a launcher or an
open window. Also I prefer my
I created a bootable 8 GB USB
icons in the top panel to save
stick with no problem. I went
real estate but that is a
straight to the full install and
personal preference.
this was using the standard
Ubuntu install program so no
The initial applications supplied
problems there; it completed
are a mixed bag. Many of them
within 30 minutes. I then used
update manager which brought are unique to Elementary and
the whole system up to date as use the brand Name
“Pantheon”. The Calculator,
at 1st November 2014.
Calendar, Screenshot, Simple
Scan and Snap are quite
Elementary booted up fast to
an attractive login screen with standard and Evince is supplied
for reading PDF files. Gnome
a limited number of preinstalled applications. I like this Font Viewer works as expected
but it is a strange choice when
as the user can then install
their favorites from the Ubuntu supplying a basic install; it can
hardly be considered essential.
repositories. The desktop is
very clean and responsive and
full circle magazine #91
n FCM#90. Arnfried Walbrecht
submitted a link to a review of
the “Elementary” OS. This sparked
my interest as I had been wanting
to test this distro for some time
but releases are few and far
between. The UK reviewer summed
it up as “my top pick these days for
Linux newcomers”.

Pantheon Photo is a fork of
Shotwell which is my favorite
photo library so no complaints
from me. It appears to be a rebranding as there are no
obvious changes.

the mouse over the timeline.

The Pantheon File Manager was
a disappointment as there are
no configuration options. You
cannot select which columns to
view or set default list/icon
Pantheon Music worked well
views. Worse, you cannot drag
with my .flac files with the
and drop files to another folder
usual playlist functions.
or to a text editor. You cannot
create bookmarks and rightPantheon Video was a different click options are very limited. It
story. It provided sound only for is very basic indeed but,
FLV files, and the video for MP4 hopefully, a work-in-progress.
files only appeared if I hovered
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Pantheon terminal worked as
expected and allowed multi
tabs but it was gray text on a
black background with black
borders. There were no options
to configure this. I installed
“RxTerm”.

supplied. My biggest problem
was to add another language –
but I suspect this is a Ubuntu
problem not unique to
Elementary. There are three
separate places where you can
add a different keyboard input.
In two of them I could not add
“Thai” but eventually I found
the third option.

The text editor supplied is
“Scratch” which is adequate
but if you select “line
wrapping” it will break lines in
the middle of a word; very odd.

I appreciate the efforts of
everybody who create new
distros. This is a beta version,
Email is handled by “Geary”
but there are so many “*buntu”
linked to the desktop. They do “Maximize” is in the top right
which would not allow me to
versions available and this
not have an “About” menu but corner and “Minimize” is
register a POP3 account. I could you can access this facility by
doesn't seem to offer anything
missing completely.
create accounts with Gmail or
new. Maybe more effort should
right-clicking the menu icon. It
Hotmail but if you select
is impossible to uninstall them. The Ubuntu “System Settings” be spent on the desktop and
“Other” and enter your email
replace the Pantheon apps with
In software Manager they are
is supplied with many items
address then the “Next” button listed as options under the
existing tried and tested
removed; there were only 19
is disabled. Maybe it would
main desktop install. I
items compared with 31 in Mint applications.
work with an IMAP address.
unchecked the options and
LMDE. This highlights the fact
clicked “Update” but they were that there is very little
“Midori” is supplied as the
still there.
customization allowed. This is a
default browser but this has a
The window manager does not matter of personal choice, but I
problem with Adobe Flash. Sites follow the common convention would like the ability to change
which require this will report
of putting “Minimize”,
the color of the panel and add
that it is not installed but, if I
“Maximize and “Close” icons
or remove applets. There are
try to install via Software
the top right corner of windows. no themes available, but a
Center, it is shown as being
“Close” is in the top left corner, selection of wallpapers is
installed. I installed Firefox and
it worked fine with the same
sites.
The Pantheon applications are
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Written by Lucas Westermann

E

arlier this month, I was offered
the chance to get a copy of

Web Development with
MongoDB and NodeJS by Jason
Krol for review. Since I had

previously been experimenting
with NodeJS, I jumped at the
chance, and worked my way
through the book quickly. After
finishing the book, I can only say
that I am impressed by the quality
of the book, as well as the teaching
method of the author.

As I’ve already said, this eBook

We b D e v Wi t h M o n g o D B & N o d e J S

manages to do almost
everything right. By the end of
the book, you’ll have been led
through the entire process of
designing and testing a web
application using Node.js and
MongoDB, as well as having
some extra information in the
last few chapters. The one
problem I ran into was in
Chapter 4 (Express.js). The
current version of npm (at the
time of writing: 2.1.2) did not
allow me to install a working
version of Express.js 3.5.1, due
to changes in dependency
packages. Instead, I had to
follow the instructions while
taking into account the
information at the end of
chapter 4 (on Express.js version
4). However, this could also
count as a plus-point towards
the book, for supplying the
necessary information in the
chapter.

out in the way one would
approach such a project. The
formatting of the book allows
the reader to clearly
understand what sections of
code are relevant to the
explanation, and the supplied
downloads offer working
examples for each chapter
(while some changes may be
required for the Express.js
files). By the end of the book,
you should have a good idea of
how to approach such a project,
as well as having a working
application. From there, you
should have a good foundation
for starting a project of your
own design. Even if you’re less
interested in NodeJS and more
interested in how such a project
should be be approached, then
this book is an excellent
resource and example.

Furthermore, if the book is not
enough of a resource for you, it
Apart from this one small
also offers relevant links, and
setback (which, in all honesty,
as much extra information as
cannot be attributed to the
can be included without
author or the book), the book is detracting from the actual
written very clearly, and laid
material of the book. Along with
full circle magazine #91
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this abundance of information,
the formatting of the book (the
pub version at least) offered a
very thorough table of
contents, and a linked index
section at the back of the book.
Couple this with the ability to
search the ebook, you should
be able to find any relevant
information as quickly and
efficiently as possible.
Link
https://www.packtpub.com/web
-development/webdevelopment-mongodb-andnodejs
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B a c k To U b u n t u

Written by Roland Hunt

ven though my main Computer
is an Acer C720 Chromebook,
I've got a secondary Laptop that
normally runs Windows that has
been recently running Windows 8.1
Pro alongside the Windows 1 0
Technical Preview in a dual-boot
setup. But today, the Windows 8.1
Install has been playing up and I
decided to wipe the HDD and start
again with ether Windows 8.1 only,
Windows 1 0 Technical Preview
only, or using the same dual-boot
setup.

burn the Video DVD that was
giving me no end of problems in
Windows, so I opened up the
Brasero CD/DVD burning program
and this is where I ran into a few
problems.

It seems as though Brasero
doesn't come with a couple of
dependencies for DVD Video
burning installed, and threw up an
error when trying to burn the DVD.
Brasero requires the mplex
(GStreamer Plug-in) and dvdauthor
(Application) installed to burn
video DVDs. A quick search in the
While backing up my Windows
8.1 Partition (mostly personal files Ubuntu Software Centre didn't find
and downloads), I came across the either of the required
dependencies, so I tried using the
Ubuntu 1 4.04 LTS .iso that I
downloaded ages ago. So, instead sudo apt get command in the
Terminal – which threw an error as
of going with a Windows Install, I
it has been that long since I last
made an Install DVD for Ubuntu
1 4.04 to go back to Ubuntu on my used the Terminal to do installs
(back when Saucy Salamander was
secondary Laptop.
being Developed). I'd forgotten the
exact apt command to get and
The Ubuntu 1 4.04 Install went
Install a package via the Terminal,
as smooth as Ubuntu Installs
probably due to using Chrome OS –
always go, and it even detected
the only Linux based OS other than
that I was connected to the
Internet which hasn't happened for Mac OS that doesn't require much
a long time when Installing Ubuntu. in the way of working in the
Terminal (so much so that the
Once I'd rebooted, I thought I'd
full circle magazine #91

Terminal is hidden away in the
Chrome OS Developer Mode). I
then Installed the Synaptic Package
Manager and was able to find
dvdauthor, but was unable to find
mplex.
So I've currently put my venture
back into fully using Ubuntu on my
secondary Laptop while I either do
some full-on digging around in
Synaptic Package or the Software
Centre or even dig around for the
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correct apt command to download
and install mplex via the Terminal.
But, since I needed the DVD
burning for Friday 24th October,
and another copy for Tuesday 28th
of October, I ended up doing the
only viable option until I've got the
time to sort it out properly, and
installed the Windows 1 0 Technical
Preview. But, as I tend to use only
my Chromebook, I don't know how
long my secondary Laptop will end
up with Windows back on it.
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MY STORY
I love using Ubuntu and Linux
over Windows, but the problems
that I've encountered after having
a long absence from Ubuntu and
the full Linux experience, have
done only one real thing – which is
show me how simple and easy it
can be to use Linux – if it's done in
a consumer orientated and
consumer friendly way Like Google
has done with Chrome OS.
Windows is ok for people who
want something that just works,
but is proprietary and prone to
viruses; Chrome OS is for people
who want something that just
works, is Linux based, and who
don't mind living in the Cloud; Mac
OS is for people who want
something that just works, is more
mainstream like Windows along
with being a proprietary OS, but
also *nix based, whereas Linux
based OS's like Ubuntu are more of
a nerdy OS for someone who
doesn’t mind getting their hands
dirty in the Terminal, and don’t
mind spending hours getting
things all working. I'm the nerdy
type, but since using Chrome OS, I
don’t seem to be able to find the
time to mess around in forums and
in the Terminal trying to find what I
need to get something done, then
have to spend twice as long

troubleshooting why the command
didn’t work.
I really love having a free and
Open Source OS on my secondary
Laptop, but if I can't get it to do
something as simple as burn a DVD
video – without the hassle of
having to troubleshoot and figure
out how to get a missing
dependency – then I don't know if I
should go back to Ubuntu any-time
soon. It’s ok for now – with
Windows on my secondary Laptop
until I've got the time to figure
things out in Ubuntu, or just go for
the next best thing when I next
have to wipe the slate on my
secondary Laptop and start again
and dual-boot Ubuntu and
Windows, or just attempt a triple
boot setup of Windows 1 0
Technical Preview, Windows 8.1 ,
and Ubuntu.
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LE TTE RS
O MINOUS N EWS

I

am running Ubuntu 1 4.04, and,
from time to time, I receive an
ominous message that there is a
system problem. I am then asked if
I would like to report the problem.
I always say yes, then the window
alerting me of said problem closes.

If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org .
PLEASE NOTE: some letters may be edited for space.

repliedexplaining that all errors go
to http://errors.ubuntu.com/and
that you can findyour past reports
by going to System settings >
Security & privacy > Diagnostics >
Show previous reports. There’s also
a wealth ofinformation on this at
https://wiki.ubuntu.com/ErrorTrack
er with a very informative video (on
YouTube) at:
https://www.youtube.com/watch?v
=PPQ7k0jRUE4#29m50s

My question is: what exactly
happens when I click yes? Who is
alerted? How many people are
Many thanks to Alan for clearing
required to report the same
that up for us.
problem before the problem is
deemed serious enough for action?

John Niendorf

Full Circle Podcast
Episode 41 , Trusted
To Fail!!
Welcome to our new format
show, there are several
changes from the previous
format, the most important
being we are now recording
together at the Blackpool
Makerspace in the office.
This Episode we Test Ubuntu
1 4.04, Review of Official
Ubuntu Server Book.
Your hosts:
• Les Pounder
• Tony Hughes
• Oliver Clark

Ronnie says: I asked Alan Pope
from Canonical andhe graciously

from the
Blackpool (UK) LUG
http://blackpool.lug.org.uk

Join us on:
goo.gl/FRTMl

facebook.com/fullcircle
magazine
twitter.com/#!/fullcirclemag
linkedin.com/company/fullcircle-magazine
ubuntuforums.org/forum
display.php?f=270

FULL CIRCLE N EEDS YOU !
Without reader input
Full Circle would be an
empty PDF file (which I don't
think many people would find
particularly interesting). We are
always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.
See the article Writing for Full
Circle in this issue to read our
basic guidelines.
Have a look at the last page of
any issue to get the details of
where to send your
contributions.

full circle magazine #91
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Q &A

If you have a Linux question, email it to: misc@fullcirclemagazine.org , and
Gord will answer them in a future issue. Please include as much
information as you can about your query.

Compiled by Gord Campbell

I get a later version
Q ofHowSoundcan Converter
than the
one in the standard Ubuntu
repositories?

A

Add the getdeb.net
repository. If you go to its
website, there are instructions on
how to do this.
Getdeb is not all sweetness and
light. It is frequently down, which
slows down installing updates by
several minutes.

I'm using Lubuntu 1 4.04. Does
Q anyone
have any help or info
on how to run a Powerpoint style
program?

A

Install LibreOffice. One of its
components, Impress, can
"play" many Powerpoint
presentations, and can generate
presentations which can be played
in Powerpoint.

drive. Now my drive looks like this:
sda1 246 GB EXT4
sda2 extended partition
sda5 4 GB swap
--- 70 GB of unused space.

How can I use the 70 GB?

A

You could use Gparted to
create another partition and
format it. Launch it with the
command: gksudo gparted

A

Eventually there will be an
(Thanks to
overcrowding on the sidebar. Is
monkeybrain20122 in the
there anything I can do to get icons Ubuntu Forums) Take a look at R.
on the desktop?

A

(Thanks to CantankRus in the
Ubuntu Forums) Copy the
application launcher from
/usr/share/applications to your
desktop.

Q

I installed Ubuntu 1 4.04 LTS
Then you could edit fstab so the
(32-bit). Not sure what format
partition is automatically mounted I selected for the hard drive. How
at logon.
can I find out?
Another approach would be to
boot from the installation media,
run Gparted, delete the swap and
extended partitions, expand sda1
to all but 4 GB of the hard drive,
then create a new swap partition.
Please be sure you have good
backup before you modify
partitions!

A

This command will display it:
df -T

How can I access a shared
Q folder
on a remote machine?

A

Google "sshfs tutorial" and
you will find some step-bystep answers.

I cannot put my application
What package should I use to
I used Acronis to make an
Q
Q
Q image
icons on my desktop, they will
do some heavy-duty statistical
of my hard drive, then
mount only on the sidebar.
analysis for a PhD thesis?
restored it onto a different, larger
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TOP QUESTIONS AT
ASKUBUNTU
* Eye tracking mouse cursor for
Ubuntu
http://goo.gl/y6px4d
* Creating a network with 1
Windows PC and 1 laptop using
Ubuntu 1 4.04
http://goo.gl/s9qu32
* What is the 'command' command
and what is it used for?
http://goo.gl/8ibebf
* Mounting Windows Phone 8.1 on
Ubuntu 1 4.04
http://goo.gl/MFWpHi
* Is chrubuntu the same as Ubuntu
and can I update it?
http://goo.gl/YeVR7J
* How to change default
contents ^

Q&A

"Categories" and "Sources" in Unity how powerful the computer is.
Dash?
Perhaps surprisingly, "the
http://goo.gl/iAf91 o
community" provided a readymade fix for Windows 8, in the
* Can I recover command-line
form of Classic Shell. Other than
deleted file from trash bin?
the user interface, Windows 8 is
http://goo.gl/s6fjKE
the most stable Windows yet, so
there is a good solution for clients
* Assembler similar to TASM on
who need to use Quickbooks, Sage
Ubuntu?
and other accounting software.
http://goo.gl/bD7r9C
* Popup ad virus on both Chrome
and Firefox
http://goo.gl/cFJcgQ

TIPS AND TECHNIQUES
Resource Allocation Error

F

rom my perspective, a couple
of years ago, Microsoft, the
Gnome project and Canonical all
galloped off at full speed into the
weeds; they each came up with
new user interfaces which reduced
my productivity.
Since Gnome is, in part, a user
interface, it became irrelevant to
me. Linux provides lots of choices
beyond Ubuntu/Unity, so I
regularly use XFCE (Xubuntu) or
Cinnamon (Mint), depending on

kernel. (See FCM#84.) Surely I am
not the only one with this type of
experience?
So here is my request to
Canonical: first fix the bugs, then
think about other things.

But Canonical didn't stop at
Unity; it is also working on
replacements for other
components of Ubuntu, such as
Mir. Those might be good things to
work on, but I assert that it means
they are not putting enough
resources into making Ubuntu a
solid computing platform. The
weekly Ubuntu-News Digest
includes bug stats, and not that
long ago, the number of Critical
bugs was in the nineties; it's
currently over 220.
This affects me. My primary
computer does not reliably run any
of the Canonical operating
systems, beginning with 1 4.04 and
continuing in 1 4.1 0. They work for
some random number of hours,
then lock up. Yet the system is rock
solid with Linux Mint 1 3 and my
unusual installation of the 3.1 3.5-0
full circle magazine #91

Gord had a long career in the

computer industry, then retired for
several years. More recently, he
somehow found himself "The IT Guy"
at a 1 5-person accounting firm in
downtown Toronto.
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U B U N T U G AM E S

B o rd e rl a n d s 2

Written by Oscar Rivera

O

n September 30, 201 4, Steam
released Borderlands 2 for
Linux, two years after its initial
release on Windows PC. Having
played the original Borderlands, I
was kind of excited to find out that
its sequel – Borderlands 2 – would
be coming to Linux. Like other
games I've reviewed in the last few
months, there was no indication of
this game being able to run on PCs
with AMD (or Intel) graphics cards,
it was supported only for Nvidia.
However, once again I decided to
read the reviews from AMD owners
and almost immediately I felt
comfort in finding that the game
was running pretty well with AMD
graphics cards. So, I decided to give
it a try and play it. So far, so good.
Borderlands 2 is an action, first
person, shooter game, developed
by Gearbox Software, published by
2K Games, and ported to Linux by
Aspyr Media. The timing of the
Borderlands 2 release for Linux
couldn't have been more perfectly
planned, as ‘Borderlands: The PreSequel’ was released a mere two
weeks later for Microsoft Windows,
OS X, Playstation 3, Xbox 360, and

Linux. The Pre-Sequel serves as a
sequel to the original Borderlands,
but also a Prequel to Borderlands
2, so basically somewhere in
between. If this sounds confusing
to you, don't worry, it is confusing
to most of us.
Borderlands 2 can be played
with a mouse/keyboard as well as
with a game controller. No matter
what input device(s) you use to
play the game, the game-play
mechanics are pretty much the
same as most first-person
shooters. You walk, run, duck,
jump, shoot, etc, just like you
would in most other FPS games,
but you can also perform your
character's special moves. In fact, I
made a lot of progress without the
need for a tutorial before I found
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out about the special moves –
because of how similar this game is
to other first-person shooters.
What sets Borderlands 2 apart
from other FPS games lies in the
presentation and in its comedy.
The artwork is a sort of hybrid
cartoon/realistic style. Ever since
the original Borderlands game, the
developers decided to go with
what they call ‘cell shading
graphics’ which is what
differentiates the game from other
FPS games that might look more
realistic. The comic, cartoonist
effect actually fits well with the
direction the Borderlands series
has taken. Not only that, but it also
completely sets it apart from other
games from the same genre. The
comedy is not only outrageous, but
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also very often just plain old crazy,
off-the-wall humor that leaves you
wondering who in their right mind
thought about these things.
Borderlands 2 can be played in
one-player campaign mode, or
there's also the option to do a
multi-player mode where you have
the possibility for up to a fourplayer co-op. With that said, you've
got four players, or Vault Hunters,
to choose from. Each Vault Hunter
comes with his (her) own playing
style, abilities and special moves.
The game takes place in the planet
of Pandora, where you must find a
series of vaults – before Handsome
Jack (the villain) finds them to carry
out his evil plans. Leading the way
and guiding you as you progress on
your quest is a robot by the name
of CL4P-TP (ClapTrap), who kind-of
reminds me of a loopy R2D2. The
little fellow does have a few
redeeming traits, like helping you
in opening many doors & gates, or
getting past other odd characters
who otherwise wouldn't let you
through. Anyone who's played the
original Borderlands will definitely
remember ClapTrap, as well as
contents ^

UBUNTU GAMES

many returning characters.
Although there may be many
familiar faces from the original
game, there are also as many, if not
more, new characters introduced in
this game. The story takes many
twists and turns along the way, but
it keeps you engaged as you
progress in the desolate planet of
Pandora. It's a well made game
that keeps the player entertained.
To play Borderlands 2, it's
imperative that you have a Steam
account. If you don't have one,
you'll have to get one. Through
Steam, you can currently get the
game for $1 9.99, or be on the
lookout for a special deal from
other sources, though once you
purchase it, you'll have to open a
Steam account.

Other than the occasional and very
rare 2-3 second delay that I've so
far encountered only twice, there
have been no other problems with
the actual game. The real bug I've
come across is when I take screenshots. The screen-shot itself will
look perfect, but the left side will
always be elongated thus making
the screen-shot seem longer than it
really is. I've taken the time to
clean up the screen-shots for this
article simply by cropping the part I
need. It's a very minor detail since
it's not something you'll encounter
while playing the game, and I
believe it's experienced only by
AMD graphics cards so it's almost a
non-issue.
I am not a big fan of first-person

shooters, but this game is on a
category of its own, and it has been
very enjoyable to play. I definitely
do recommend this game whether
you like the FPS genre or not.
Maybe it's the way it looks; instead
of going for the realistic look, it
opted to go for the cell-shading
cartoon look. Maybe it's the humor,
because it has quite a bit of it, and
some of it is outrageous. Or maybe
it's just a great game, like many
critics have said.
I give the game 4 out of 5 stars
because of AMD cards not being
fully supported yet.

M Y G AMING SETUP
I played Borderlands 2 with my

custom-made desktop PC
consisting of an AMD FX-61 00
3.3GHz CPU (over-clocked to
3.5GHz), an Asus M5A97-EVO
motherboard, a Sapphire Radeon
HD 5770 graphics card, 8GB of
Kingston Hyper X RAM, and a 1 TB
Seagate Barracuda hard drive. The
software used was Ubuntu 1 4.04.1
LTS with Unity desktop and AMD
1 3.9 proprietary graphic drivers.

Minimum System Requirements:

OPERATING SYSTEM: SteamOS,
Ubuntu 1 4.04
CPU PROCESSOR: Intel Core 2
Quad, AMD Phenom II X4
CPU SPEED: 2.4GHz
MEMORY: 4 GB RAM
HARD DISK SPACE: 1 3 GB
VIDEO CARD (NVIDIA): Geforce 260
VIDEO MEMORY (VRAM): 1 GB

CONCLUSION
I've encountered very few and
minor glitches in Borderlands 2
since I began playing it. I had my
doubts as to whether I'd be able to
play this game with my AMD
Radeon HD 5770 graphics card
because the minimum
requirements list only Nvidia
graphics cards, but I can testify
that AMD cards work just fine.

Oscar graduated from CSUN, is a

Music Director/Teacher, beta tester,
Wikipedia editor, and Ubuntu Forums
contributor. You can contact him via:
www.gplus.to/7bluehand or email:
www.7bluehand@gmail.com
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M Y D E S KT O P

Your chance to show the world your desktop or PC. Email your screenshots and
photos to: misc@fullcirclemagazine.org and include a brief paragraph about your
desktop, your PC's specs and any other interesting tidbits about your setup.

Screenlets 0.1 .6 take care of
displaying info, with few resources
• Cairo - Dock
• Wallch Wallpaper Changer
• Use desktop thumbnails for a
"Photo album" of people
important to me
I really use the Unity launcher to
start 90% of my apps, etc. The
dock is an extra place I will
sometimes look as it displays any
program running. I started late in
Linux, at age 45. Interesting to
note, my PC is also used
occasionally by a man aged 68
years, a testament to the fact that
Ubuntu is becoming more and
more popular.

Brian Bogdan

I

've really changed this over the
last few months. Here's some
info to post in "My Desktop" if you
like:

• HP TouchSmart Core Duo P7450
(2.1 3GHz), 4GB DDR3 RAM, 1 .5TB
HDD, 23" Touchscreen Desktop PC
• Ubuntu 1 4.04
• Unity (of course!)
full circle magazine #91

Azenis icon theme, (in this shot,
you can see them in the bottom
dock)
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MY DESKTOP

• OS : Kubuntu 1 4.04LTS
• PC Specs: Intel Dual CPU @
1 .8GHz and 2GB RAM

I love Kubuntu. It’s customisable
and has all the original compiz
features that first drew me to
GNU/Linux.
full circle magazine #91

Desktop Cube: Cylinder

Christo A Van Wyk
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H O W TO CO N TRI B U TE

Full Circle Team

FCM#89

FULL CIRCLE NEEDS YOU!

A magazine isn't a magazine without articles and Full Circle is no
exception. We need your opinions, desktops, stories, how-to's, reviews,
and anything else you want to tell your fellow *buntu users. Send your
articles to: articles@fullcirclemagazine.org

Deadline :

Sunday 07th Dec. 201 4.
Release :
Friday 26th Dec. 201 4.

We are always looking for new articles to include in Full Circle. For help and advice please
see the Official Full Circle Style Guide : http://url.fullcirclemagazine.org/75d471
Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our forum via: fullcirclemagazine.org

Editor - Ronnie Tucker
ronnie@fullcirclemagazine.org
Webmaster - Rob Kerfia
admin@fullcirclemagazine.org
Podcast - Les Pounder & Co.
podcast@fullcirclemagazine.org
Editing & Proofreading
Mike Kennedy, Gord Campbell, Robert
Orsino, Josh Hertel, Bert Jerred, Jim
Dyer and Emily Gonyer
Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

Getting Full Circle Magazine:

EPUB Format - Recent editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with
the epub file, you can drop an email to: mobile@fullcirclemagazine.org

Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to
spread the word about FCM and Ubuntu Linux.

Google Play - You can now read Full Circle on Google Play/Books. Either search for 'full circle magazine' or
click this link: https://play.google.com/store/books/author?id=Ronnie+Tucker
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